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ABOUT THIS MANUAL

This manual describes how to install and use the 
LAN Workplace® for DOS software. This software includes 
components for both Windows and standard DOS. This manual 
is divided into the following parts:

Part I, General Information, gives an overview of the LAN 
Workplace for EOS and provides a step-by-step procedure for 
installing and configuring the software.

Part II, Windows Applications, describes how to use the LAN 
Workplace utilities under Microsoft Windows 3.0.

Part III, Command-Line Utilities, describes how to use the LAN 
Workplace utilities from a standard DOS prompt.

An index is provided for easy cross-reference.

Related Publications

The following publications describe related LAN Workplace for 
DOS products:

1. LAN Workplace for DOS Administrator's Guide, Publication 
No. 100-000882-001, Novell, Inc., 1990.

2. LAN Workplace for DOS Socket Library API Reference 
Manual, Publication No. 100-000883-001, Novell, Inc., 1990.
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Documentation Conventions

This manual uses the documentation conventions described 
below. Specifically, these conventions are used when referring to 
the following:

• Command lines and command-line components

• System responses

• Syntax statements

• File entry formats

The characters <>,[],{), and I are normally used as 
metacharacters and as such you must not type these as part of 
user input.

Regular (that is, nonbold, nonitalicized) character strings 
represent system responses. Examples:

C>
Bad command or file name

Bold characters represent user input, which must be entered 
exactly as shown. Because DOS is not case-sensitive, you can use 
any combination of uppercase and lowercase letters. Example:

TNVT220

< > (angle brackets) enclose descriptive names for items that the 
system replaces with appropriate values in the actual display. An 
exception is <cr> or <Enter>, which represent the Enter key. 
Example:

Connected to <remote_host>

Italicized lowercase or uppercase character strings show 
descriptive names for items that you must replace with 
appropriate values. Example:

COPY source_file destination_file

xii
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[ ] (square brackets) enclose an optional item or multiple optional 
items that are separated by the vertical bar (I) character. If 
multiple items are shown, you can specify only one of them. 
Example:

DIR [directory_name | file_name]

( } (braces) enclose multiple items that are separated by the 
vertical bar (I) character out of which you must specify only one 
item. Example:

TNVT220 -C {ASCII | BINARY}

I (vertical bar) separates items in a list of alternatives. If the list is 
enclosed in [ ], you can use any one and only one of the items. If 
the list is enclosed in {}, you must use one and only one of the 
items.

. . . (ellipses) indicate that the preceding item may be repeated 
multiple times. Example:

PRINT file_name ...

A (caret) represents the Ctrl key when shown in combination 
with another key. However, when shown with the Ctrl key itself, 
A represents the caret character (Shift-6). Examples:

*Z 
Ctrl-A

Numerical values are specified in decimal or hexadecimal bases. 
The decimal numbers have no prefixes or suffixes. The 
hexadecimal numbers are either prefixed with a Ox or OX (zero 
and the letter X) or suffixed with the letter H. For example, 
0xA024 and A024H both represent hexadecimal numbers.

111!^ Important information is emphasized with an arrow, as 
shown to the left of this sentence.

Combination key strokes are hyphenated and capitalized. 
Because DOS is not case sensitive, you can use upper case or 
lower case letters. Example:

Alt-T

xiii
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Tables or figures that continue onto another page are marked 
with an arrow at the end of the current section of the table, as 
shown below.

The end of a table or figure is marked with a box, as shown 
below.

The installation procedure uses the following conventions:

• Paragraphs in this typeface are system messages or prompts.

• The symbol ® precedes user input or system prompts that 
require user input.
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1
INTRODUCTION

The LAN Workplace® for DOS software provides TCP/IP 
transport system software, HostAccess™ utilities, and NetBIOS 
software. The LAN Workplace software is designed to run on 
PCs, PS/2s, and compatible systems connected to a 
TCP/IP-based network.1 Using the LAN Workplace software, 
you can communicate with remote hosts and other nodes on 
your local network. You can also communicate with other 
TCP/IP-based networks that are connected to your network via 
Internet gateways.

1. In this manual, the terms PC, personal computer, and workstation refer to PC ATs, 
Compaqs, PS/2s, and compatible systems, including 80386-based systems 
running DOS.

The TCP/IP transport system software provides TCP/IP protocol 
software and utilities for monitoring and administering an 
Ethernet network. The HostAccess utilities let PCs and PS/2s 
communicate with remote hosts and other nodes on your local 
network. The NetBIOS Application Program Interface lets you 
run, without modification, all PC network applications designed 
for the standard NetBIOS interface.

This manual focuses primarily on using the LAN Workplace 
HostAccess utilities. Some of these utilities are designed to run 
only in a Microsoft Windows 3.0 environment; others run in a 
DOS environment or in a DOS window under Windows 3.0. 
Although the tasks you perform in each environment are the 
same, the software components used to perform the tasks are 
different. When you install the LAN Workplace software, the 
installation procedure installs components for either the 
Windows or DOS environments, or for both environments.
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Using the LAN Workplace HostAccess utilities, you can perform 
the following operations:

• Transfer files to and from remote hosts.

• Use your DOS workstation as a terminal and log in to a 
remote host.

• Print files on a printer attached to a remote host.

• Execute commands on a remote host.

Table 1-1 summarizes the LAN Workplace utilities that allow you 
to perform these operations.

Table 1-1
Summary of LAN Workplace Utilities

Type of Utility Description

File Transfer Utilities

File Express File transfer utility for Microsoft Windows 3.0. Copies files, directories, 
and directory trees between your workstation and a remote host using 
the FTP protocol. Performs directory and file operations on the remote 
host, such as listing and changing working directories. Creates and 
deletes files. This application runs only under Windows 3.0.

FTP Copies files, directories, and directory trees between your workstation 
and a remote host. Performs directory and file operations on the remote 
host such as listing or changing working directories.

RCP Copies files, directories, and entire directory trees between your 
workstation and a remote host.

TFTP Copies single files between your workstation and a remote host using 
the TFTP protocol.

Serving FTP The FTP server program for Microsoft Windows 3.0 that handles 
requests for services from File Express and FTP clients on the network. 
Serving FTP can run in its own window in the background. This 
application runs only under Windows 3.0.
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Table 1-1
Summary of LAN Workplace Utilities (Continued)

Utility Description

Terminal Emulation Utilities
TELAPI Telnet client program required by Host Presenter and TNVT220. Also 

supports various third-party terminal emulators.

TNVT220 Emulates a DEC VT220, VT100, or VT52 terminal directly connected to a 
remote host. This means you can log in to a remote host running a 
TCP/IP Telnet server and perform any operations supported by the 
remote host.

Host Presenter A Windows 3.0 program that emulates a DEC VT220, VT100, or VT52 
terminal. Also has a script processor called Script Director. This 
application runs only under Windows 3.0.

TSU TelAPI configuration program. Required by third-party terminal 
emulators.

Remote Printing Utilities

RPD Deletes a job from the print queue of a remote printer.

RPR Prints a file on a remote printer.

RPS Displays the status of jobs printing on a remote printer.

Remote Command Utilities

REXEC Executes a single command on a remote host. A password is required to 
access the remote host.

RSH Executes a single command on a remote host. No password is required 
to access the remote host.
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INSTALLATION

The LAN Workplace for DOS software includes components for 
Windows and for standard DOS. The LAN Workplace 
installation procedure allows you to install either the Windows 
or the DOS components, or both components.

This chapter describes the hardware and software you need to 
install the LAN Workplace software. It also provides a 
step-by-step procedure for installing and configuring the 
software. For a detailed description of the installation results, 
refer to the LAN Workplace for DOS Administrator's Guide.

Prerequisites for Installation

To install and use the LAN Workplace for DOS software, you 
need a workstation connected to a network through an 
appropriate network adapter. The connected workstation should 
have the following hardware and software components:

• Computer. For standard DOS applications, an IBM PC XT, 
AT, PS/2, or an 80286-based, 80386-based, or 80486-based 
compatible; for Microsoft Windows 3.0 programs, an IBM 
PC AT or PS/2, or an 80386-based or 80486-based 
compatible.

• Disk Drive. Your workstation must have at least one hard 
drive with a minimum of 2.8 Mbytes available disk space 
and either a 35-inch disk drive or a 5.25-inch disk drive 
capable of reading low-density floppy disks.

Prerequisites for Installation 2-1
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• Operating System. IBM DOS Version 3.3 (or later) or 
Microsoft DOS Version 3.3 (or later) installed and running 
on your system.

• Network Adapter. A network adapter (Ethernet, Token 
Ring, or ARCnet) must be installed in your workstation.

• Open Data Link Interface (ODD Workstation Software. 
You must install the DOS ODI workstation software as 
described in the NetWare DOS Shell for ODI manual in this 
package.

1111^* When completing the DOS ODI installation, you 
must create your boot disk on your hard disk. In 
addition, you must make the recommended 
modifications to your AUTOEXEC.BAT file, 
CONFIG.SYS file and, if necessary, NET.CFG file.

Preparing for Installation

You will need the following information while installing the 
LAN Workplace software. The installation procedure prompts 
you for this information:

Drive on which to install software:___________________________
Internet address for your workstation, if not using RARP:
Internet subnetwork mask, if subnetworks exist:
Internet router address, if applicable:
Domain Name, if using Domain Name Server:
Domain Name Server’s IP Address, if applicable:
Local user name for the R-utilities:

The installation procedure also prompts you to make the 
following decisions:

Do you want to use the default configuration values? The default 
configuration provides 8 TCP connections and 4 NetBIOS sessions.

Do you want to load RFC NetBIOS during system boot?
Will you use applications written for LAN Workplace for DOS 3.5?
Do you want your system files updated?
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Installing and Configuring the Software

This section provides the procedure for installing and 
configuring the LAN Workplace software. The procedure uses 
the following conventions:

• Paragraphs in this typeface are system messages or prompts.

• The symbol precedes user input or system prompts that 
require user input.

The installation procedure displays help messages and prompts 
you for specific input. The system prompts may be either of the 
following types:

• Prompts that ask for specific information, such as an IP 
address. To respond to these prompts, type the required 
information and then press the Enter key.

• Prompts that display more than one option. To select a 
specific option, highlight it using the arrow keys and then 
press the Enter key.

The installation procedure copies the following software 
components to your hard disk:

• LAN Workplace for DOS, TCP/IP Transport 4.0

• LAN Workplace for DOS, HostAccess 4.0

Figure 2-1 depicts graphically the steps required to install the 
LAN Workplace software.
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Figure 2-1
Installation Procedure
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Figura 2-1
Installation Procedure (continued)

These prompts appear only if you 
do not have a RESOL V. CFG file 
from a previous version of the 
LAN Workplace software on your 
workstation
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Figure 2-1
Installation Procedure (continued)

2-6 Installing and Configuring the Software



Installation

The following is a step-by-step procedure for installing and 
configuring the LAN Workplace software:

1. Insert the LAN Workplace distribution disk in drive A.

2. Start the installation:

C> AJNSTALL <Enter>

3. Verify drive:

Select install drive:

C:
D:
E:

After you select the drive and press Enter, the system 
copies the installation files to the selected drive.

4. Indicate if you want to install the Windows Applications 
portion of the LAN Workplace for DOS:

Do you wish to install the Windows Applications portion of 
LAN Workplace?
Yes No <Enter>

If you choose No, skip to Step 6. Otherwise, continue with 
the next step.

5. If you have Windows 3.0 installed on your system and the 
Windows directory is on your DOS path, skip to Step 6. 
Otherwise, continue with Step 5a.

a. Indicate whether you have Windows 3.0 installed on 
your system:

Do you have Windows 3.0 installed on your computer?
Yes No <Enter>

If you choose No, skip to Step 6. Otherwise, continue 
with the next step.
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b. Specify the drive and full directory path where 
Windows 3.0 is installed on your system:

W Enter the path (including drive) where Windows 3.0 is 
installed on your computer.
windows_drive_and_pat/xEnter>

6. If you do not have enough disk space to install the LAN 
Workplace software, you are prompted to abort the 
installation procedure:

SB The drive you wish to install LAN Workplace 4.0 on does not 
have enough disk space. Abort installation?
Yes No <Enter>

You may want to choose No if you are reinstalling the 
LAN Workplace software and you know that the 
installation will overwrite existing files that are taking up 
the required disk space.

7. You must have the following information about your 
system and network in order to complete the installation:

To install the LAN Workplace software, you must know the 
following information:

Internet address for your workstation, if not using RARP.
Internet subnetwork mask, if subnetworks exist.
Internet router address, if applicable.
Domain Name, if using Domain Name Server.
Domain Name Server’s IP Address, if applicable.
Local user name for the R-utilities.
Do you want to use the default configuration values?

(8 TCP connections and 4 NetBIOS sessions)
Do you want to load RFC NetBIOS during system boot?
Will you use applications written for LAN Workplace for 

DOS v3.5?
Do you want your system files updated?

Press Enter to continue.

If you wish to end the installation procedure to gather this 
information, press the Escape key twice. Otherwise, 
continue with the next step.
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8. If you have an EXOS 205 or EXOS 215 card and you have 
installed Windows 3.0, you must change the interrupt 
level on the EXOS board if it is set to 2.

Windows 3.0 and an EXOS 205 or 215 card have been 
detected on your system. Windows will not run if the IRQ 
(interrupt) on the EXOS card is 2. If your 
\XLN\HARDWARE\EXCELAN.HDW file has 'Signal' (interrupt) 
set to 2, then you should change the interrupt on the EXOS 
board. A good alternative is usually 5 or 7.

Press Enter to continue.

1111^ If you change the interrupt on your EXOS card after 
completing the installation procedure, you must 
also change the value of Signal in the 
EXCELAN.HDW file and the value of Interrupt for 
the EXOS card in the NET.CFG file.

9. Indicate if a RARP server will provide your IP address:

Will a RARP server provide your IP address?
Ye« No <Enter>

If you select Yes, skip to Step 11. Otherwise, continue with 
the next step.

10. Specify your IP address:

Enter your IP address
IP_address <Enter>

You must enter your IP address in four-part dotted 
notation using either decimal or hexadecimal digits.

11. Indicate if your network is partitioned into subnetworks:

Hi Is your network partitioned into subnetworks?
Yes No <Enter>

If you select No, skip to Step 13. Otherwise, continue with 
the next step.
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12. Specify the subnetwork mask for your workstation:

* Enter your subnet mask 
subnetwork_mask <Enter>

You must enter your subnetwork mask in four-part dotted 
notation using either decimal or hexadecimal digits.

13. Indicate if your network has an IP router:

■ Does your network have an IP router?
Yes No <Enter>

If you select No, skip to Step 15. Otherwise, continue with 
the next step.

14. Provide your IP router address:

Ü Enter your IP router address 
IP_router_address <Enter>

You must enter your IP router address in four-part dotted 
notation using either decimal or hexadecimal digits.

15. Indicate if you accept the default configuration values:

Do you want to use the default TCP/IP configuration 
parameters?
Yes No <Enter>

To accept the default values for the TCP/IP configuration 
parameters, press the Enter key. The default values are 
adequate for most installations.

If you need more than 8 TCP connections or more than 4 
NetBIOS sessions, or if you have more than 8 UDP ports 
concurrently active, select No. Refer to Chapter 2 of the 
LAN Workplace for DOS Administrator's Guide for 
information on changing the default values before 
continuing with the next step.

16. If a previous version of the LAN Workplace software 
created a RESOLV.CFG file, and if that file is in the 
\XLN\TCP directory, the installation assumes that the 
information in RESOLV.CFG is correct and that you are 
using the Domain Name System. If this is the case, you 
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skip to Step 18. Otherwise, respond to the following 
prompt:

SI Does your network have a Domain Name Server?
Yes No <Enter>

If you select No, skip to Step 19. Otherwise, continue with 
the next step.

17. Provide Domain information:

a. Enter your site's Domain Name:

Enter the Domain Name for your site 
domain_name <Enter>

b. Specify the IP address of your Domain Name Server:

H Enter your Domain Name Server’s IP Address 
domain_name_s&rver‘s_IP_address <Enter>

You must enter your Domain Name Server's IP address in 
four-part dotted notation using either decimal or 
hexadecimal digits.

18. Indicate if you want to load NetBIOS automatically each 
time you boot your system:

H Do you want to load RFC NetBIOS during system boot?
Yes No <Entei>

Select No if you do not plan to run third-party NetBIOS 
applications. If you select No, and later you wish to run 
third-party NetBIOS applications, you must manually load 
NetBIOS.

19. Indicate if you intend to use third-party applications 
developed to run on LAN Workplace v3.5:

X Will you be using applications written for 
LAN Workplace for DOS v3.5?
Yes No <Enter>

Select No if you do not plan to run third-party NetBIOS 
applications. If you select Yes, the AUTOEXEC.BAT file 
automatically loads a converter during system boot. This 
converter allows third-party applications developed to run 
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on the LAN Workplace 3.5 TCP/IP transport to use the 
new LAN Workplace 4.0 transport.

20. Provide your user name:

Enter your user name. Your user name will be used by the 
LAN Workplace HostAccess R-utilities (RCP, RSH, REXEC, 
RPR, RPD, and RPS) when accessing a remote host: 
user_name <Enter>

21. Indicate if you want to update the system files on your 
workstation:

Do you want your system files updated?
Yes No <Enter>

Select Yes if you want the system files on your workstation 
automatically updated. In this case, the installation 
procedure creates copies of the existing AUTOEXEC.BAT, 
CONFIG.SYS, NET.CFG, PROGMAN.INI, SYSTEM.INI, 
and WIN.INI, with the extension .SAV. Otherwise, the 
installation procedure creates updated system files with 
the extension ,LWP and you must update the system files 
manually to run the LAN Workplace for DOS. Refer to the 
LAN Workplace for DOS Administrator's Guide for 
information on the system files.

1111^ After installation, you should back up all modified 
system files. If you make unsuccessful changes to 
the files or if the files become corrupted, you can 
use the backup files to restore the Windows 
configuration for the LAN Workplace.

Following Step 21, the installation program prompts you 
for each distribution disk and copies the LAN Workplace 
files to your hard disk.

When the program completes copying the files, it modifies 
your system files if you requested it to do so, and displays 
the following:

Installation completed properly.

22. Press any key to return to the DOS prompt. Then reboot 
your workstation.
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3
USING THE HOST PRESENTER

TM
The Host Presenter program is a Microsoft Windows 
application that lets your workstation emulate a terminal and 
connect to other computers on the network. You can emulate a 
VT52, VT100, or VT220 terminal. Host Presenter lets you run 
multiple terminal emulation sessions on your workstation to one 
or more remote hosts simultaneously.

The Host Presenter program also processes scripts. Scripts are 
ASCII text files with commands that control the execution of the 
Host Presenter program (for example, a login script that 
automatically sends your user ID and password to the remote 
host). You can create a script with any editor that creates a 
text-only file, such as NOTEPAD. You cannot use files from word 
processors, such as Microsoft Word, unless you save them in 
text-only format. Refer to the LAN Workplace for DOS 
Administrator's Guide for information on scripts.

The Host Presenter program accesses the services of Telnet servers 
on other computers. To access these servers, Host Presenter uses the 
conventions of the Telnet Application Program Interface (TelAPI), 
and accesses the terminate-and-stay-resident (TSR) program 
TELAPI.EXE on your workstation.

The Host Presenter program runs under the Microsoft Windows 
3.0 environment. Before you begin using the Host Presenter 
program you should be familiar with Windows and know how 
to perform the following operations:

• Open Microsoft Windows on your workstation

• Open application programs under Microsoft Windows 3.0

• Stop an application program
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In addition, you should know how to use the mouse and 
keyboard to perform the following Windows operations:

• Select menus and menu items, command and option 
buttons, and check boxes

• Select items in windows, dialog boxes, and list boxes

• Mark and select text

• Reduce a window to an icon and restore it to a window

• Move and size windows

Refer to the Microsoft Windows User's Guide for information about 
operating Microsoft Windows.

Opening the help system 
from the session window

Getting Help

If you need information about terminal emulation parameters or 
one of the menu items, Host Presenter, provides an online help 
system. The online help information is arranged in a topic index, 
listing the available help topics. The help information initially 
displayed depends on which window is active when you open 
the help system. If you open the help system from the session 
window, a menu lists the information that you can access. If you 
open the help system from a dialog box, the system displays 
information pertinent to that dialog box.

To open the help system from the session window, follow these 
steps:

1. Select the Index menu item or topic from the Help menu.

The help system displays the index or information about 
the topic selected.
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To open the help system from a dialog box, click the dialog box's 
Help button. The help system displays information about the 
dialog box.

Opening the help system 
from a dialog box

For help on the help system, pull down the help menu and select 
Using Help. Using Help describes help basics, help menu items, 
and how to use the help system.

Basic Tasks

Host Presenter lets you perform the following basic tasks:

• Open a terminal session

• Copy and paste text from a terminal window

• Close a terminal session

This section discusses these tasks.

Opening a Terminal Session

Before you can open the Host Presenter program, TCP and TelAPI 
must be loaded. If you requested the installation program to modify 
your AUTOEXEC.BAT file, TCP and TelAPI are automatically 
loaded when you start your workstation. Otherwise, you must 
manually load TCP and TelAPI before loading Windows 3.0.
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DDD 
ODD

LAN Workplace

Host Presenter

To open a terminal session, follow these steps:

1. Double-click the LAN Workplace program group icon in 
Windows 3.0 Program Manager to open the LAN 
Workplace program group.

2. Double-click the Host Presenter icon to display the Host 
Presenter window with an Open Session dialog box.

Open Session

Load Profile...

Name of Host to log onto

3. Enter the name of the remote host that you want access in 
the Host Name text box

4. Click the Session Name text box to display the text 
insertion point in that box.

5. Enter a descriptive name for your session.

This name appears in the title bar on the Host Presenter 
main window, and on an icon at the bottom of the screen 
when the window is minimized. If you accept the default 
name, Host Presenter displays the default name. If you 
delete the default name and leave the session name blank, 
Host Presenter automatically assigns the host name as the 
session name.
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1111^ When you run more than one session at a time, 
assign each session a unique name. (For example, if 
you have two sessions open to one host, a database 
application in one and an electronic mail 
application in the other, you could give one session 
the name "Database" and the other "Mail.")

6. Click the Open button or press the Enter key to open a 
connection to the specified host.

The Open Session dialog box disappears and the Host 
Presenter program opens a connection to the specified host. 
When the connection is open, the session window displays 
your system prompt, as shown in the following window. You 
can now log in to the host computer.

Copying Text Between Terminal Session Windows

When you are in the Host Presenter program, you can select text 
that appears in one window and copy it to another window. You 
can copy text between your workstation and a remote host or 
between two remote hosts.
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Copying and Pasting Text from a Remote Host
You can copy text from a terminal session connected to a remote 
host to a Windows 3.0 NOTEPAD or WRITE file on your 
workstation. Assume that you want to copy the following text from 
a session on a remote host and paste it to a NOTEPAD file on your 
workstation.

Local UNIX Session
£ile fdit Transmit VT-FuncKeys VT-ShjftFuncK.eys Setup.., Help  

This is boilerplate text For all hardware products: I

This equipment generates, uses, and can radiate radio-Frequency 
energy, and IF not installed and used in accordance with the 
instructions manual may cause interFerence with radio communications. 
It has been tested and Found to comply with the limits For a Class A 
computing device pursuant to Subpart J oF Part IS oF FCC Rules, 
which are designed to provide reasonable protection against such 
interFerence when operated in a commercial environment.

To do so, follow these steps:

1. Highlight the portion of text that you want to copy from 
the remote session as follows:

a. Move the mouse to the start of the section that you 
want to copy.

b. Hold down the mouse button and move the mouse to 
the end of the text that you want to copy.

c. Release the mouse button.
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Local UNIX Session
Elle Edit Transmit VT-FuncKeys VT-ShjftFuncKeys getup... Help 

This is boilerplate text For all hardware products:

This equipment generates, uses, and can radiate radio-Frequenrn^^^H 
energy, and iF not installed and used in accordance with theHHHH 
instructions manual nay cause interFerence with radio communications. 
It has been tested and Found to comply with the limits For a Clasen! 
computing deuice pursuant to Subpart J oF Part 15 oF FCC Rules, 
which are designed to prouide reasonable protection agains^such^^M 
interFerence when operated in a commercial enuironment

2. Pull down the Edit menu and click Copy. This copies the 
highlighted text to the Windows 3.0 CLIPBOARD.

3. If it is not already running, open the Windows 3.0 
NOTEPAD program.

The NOTEPAD window appears with the text insertion 
point blinking in the upper left comer of the text area as 
shown below.

Notepad - (untitled)
file Edit Search Help
1 -
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4. Select Paste fromthe NOTEPAD Edit menu to paste the 
text from the Windows 3.0 CLIPBOARD into the 
NOTEPAD file, as shown below.

Notepad - (untitled)
file Edit Search Help_________________________________________________ 
This equipment generates, uses, and can radiate radio-frequency 
energy, and if not installed and used in accordance with the 
instructions manual nay cause interference with radio communications. 
It has been tested and found to comply with the limits for a Class A 
computing deuice pursuant to Subpart J of Part 15 of FCC Rules, 
which are designed to provide reasonable protection against such 
interference when operated in a commercial environment.)

From this point you can save the text as a NOTEPAD text file.

Copying and Pasting Text Between Remote Hosts
You can copy and paste text between terminal session windows 
on remote hosts. Pasting text to a Host Presenter window is 
much like entering the text from the keyboard.

1111^ If the text editor is a modal editor (such as vi on UNIX 
systems), you must put it in text insertion mode before 
you paste text to a file. Otherwise, the copied text will be 
pasted either incorrectly or not at all.

Host Presenter lets you copy and paste entire sections of text 
(including spaces and tabs) using line mode. If you are using the 
keyboard to highlight text, you must first select Select Line 
Mode from the Edit menu and then mark the text with one 
Shift-arrow key combination. If you are using a mouse, you must 
press the left mouse button while highlighting text. (The left 
mouse button selects line mode.)

Illl^ Selecting from the menu has no effect on the mouse 
operations.

The following example uses line mode to copy and paste text.
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To copy and paste text between files on remote hosts, follow 
these steps:

1. Highlight the portion of text you want to copy from the 
remote session, as follows:

a. Move the mouse to the start of the section that you 
want to copy.

b. Hold down the mouse button and move the mouse to 
the end of the text that you want to copy.

c. Release the mouse button.

Local UNIX Session
Elle Edit transmit VT-FuncKcys VT-ShjftFuncKcys getup... Help 

this is boilerplate text For all hardware products:

This equipment generates, uses, and can radiate radio-frequencu^^^M 
energy, and if not installed and used in accordance with theHH^H 
instructions manual may cause interference with radio communications. 
It has been tested and found to comply with the limits for a Class n| 
computing device pursuant to Subpart J oF Part 15 of FCC Rules, 
which are designed to provide reasonable protection againstsuch^^M 
interference when operated in a commercial environment

2. Select Copy from the Edit menu to copy the highlighted 
text to the Windows 3.0 CLIPBOARD.

3. Open a terminal session with the remote host where you 
want the text copied. If you have already opened a 
terminal session with a remote host, switch to that 
terminal session window.

4. Open an existing file or create a new file using the 
NOTEPAD editor.
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MarCom
£ile Edit Jransmit VT-Func^ey« VT-ShjftFuncKeys Setup... Help 

vi boilerplate^

5. If you are appending an existing file, scroll through the file 
and place the text insertion point where you want to paste 
the text.

1111^ Put the editor in insert mode, if necessary. (This 
example assumes the remote host is a UNIX system 
and the editor is vi. To put vi in insert mode, press i.)

6. Select Paste from the Edit menu of the terminal session 
where you want to paste the text.

The copied text is pasted in the remote host file.

MarCom
file Edit Transmit VT-FuncKeys VT-ShjftFuncKeys Setup... Help

This equipment generates, uses, and radiate radio-Frequency 
energy, and iF not installed and used in accordance with the 
instructions manual may cause interference with radio communications. 
It has been tested and Found to comply with the limits For a Class A 
computing device pursuant to Subpart J oF Part 15 oF FCC Rules, 
which are designed to provide reasonable protection against such 
interference when operated in a commercial environment.

11 inf If you changed the editor to insert mode, it remains in 
insert mode after pasting the text. You can continue 
adding text or you can end the insert mode and save 
the file.
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Copying a Column of a Table
If you do not want to copy an entire section, Host Presenter lets 
you copy a column of a table and use it in another document 
using block mode.

If you are using the keyboard to highlight text, you must first 
select Select Block Mode from the Edit menu and then mark the 
text using one Shift-arrow key combination. If you are using a 
mouse, you must press the right mouse button while 
highlighting the text. (Highlighting the text with the right mouse 
button selects block mode.)

1111^ Selecting from the menu has no effect on the mouse 
operations.

Assume that you have the following text on a remote host and you 
want to copy only the second column to the Windows 3.0 
NOTEPAD file on your workstation.

The following addresses are used in all documentation:

— I Local UNIX Session I ▼ at

Eile Edit Transmit VT-FuncKeys VT-ShjftFuncKeys Setup... Help

Houell, Inc. Houell, Inc.
122 East 1708 South 2180 Fortune Drive
Prouo, UT 84606 San Jose, CA 95131

t R
To do this, follow these steps:

1. Highlight the portion of text you want to copy from the 
remote session as follows:

a. Move the right mouse to the start of the section that 
you want to copy.

b. Hold down the mouse button and move the mouse to 
the end of the text that you want to copy.

c. Release the mouse button.
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Local UNIX Session

Nouell, Inc.
2180 Fortune Drive 
San Jose. CA 95131

£ile Edit Transmit VT-FuncKeys VT-ShjftFuncKeys getup... Help 
The following addresses are used in all documentation:

Nouell, Inc. 
122 East 1780 South 
Provo. UT 84606

F M
2. Select Copy from the Edit menu to copy the highlighted 

text to the Window 3.0 CLIPBOARD.

3. Open Windows 3.0 NOTEPAD.

NOTEPAD displays the text insertion point blinking in the 
upper left comer of the text area.

4. Select Paste from the NOTEPAD Edit menu.

Notepad - (untitled)
Elle Edit Search Help 
Novell, Inc.
2188 Fortune Drive 
San Jose, CA 95131

The text copied from the remote host is pasted in the 
untitled NOTEPAD file. Now you can save the file using 
the NOTEPAD editor's commands.
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Closing a Terminal Session

You can close a session with a remote host using any of the 
following methods:

• Log off from the remote host.

• Select Close Session from the File menu.

• Select Exit from the File menu.

• Select Close from the Control-menu box.

To close the session with the remote host but leave the Host 
Presenter window open for a new session, either log out from the 
remote host or select Close Session from the File menu.

1111^ Logging out is the preferred method because it informs the 
remote host that you have completed your session and 
permits the host to complete any processing necessary at 
the end of the session. If you do not explicitly log out, the 
remote host may maintain the session and block 
subsequent login attempts.

To close the session with both the remote host and the Host 
Presenter window, either select Exit from the File menu or select 
Close from the Control-menu box.

1111^ If a session is active and you close a session using either 
the File menu or the Control-menu box, a dialog box 
appears asking for your confirmation. Click the OK button 
to close the session.
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Advanced Tasks

The Host Presenter program lets you perform the following 
advanced tasks:

• Open multiple sessions with one or more remote hosts

• Capture data from a session

• Print displayed text

• Change fonts

• Change text colors

• Change the display

• Restore the default profile settings

• Run a script file

• Attach a script file to a key

• Detach a script file from a key

• Use national terminal types

This section discusses these advanced tasks.

Opening Multiple Sessions

The Host Presenter lets you open up to ten terminal emulation 
sessions on one or more remote hosts simultaneously, without 
reducing the current session to an icon. Using Windows sizing 
techniques, you can arrange the terminal session windows 
displayed on your screen. Displaying multiple session windows 
is useful when you need to monitor both remote hosts when 
passing data between them. To open multiple sessions, follow 
these steps:

1. Open a session as described in the section Opening a 
Terminal Session.
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2. Return to the Windows 3.0 Program Manager, dick the 
LAN Workplace program group icon, and begin a second 
session by clicking the Host Presenter icon.

3. If the new session is to the same remote host, enter a 
unique Session Name in the Open Session dialog box.

If the new session is to a different remote host, enter the 
name of that host and a unique Session Name in the Open 
Session dialog box.

4. Repeat these steps until you open as many terminal 
sessions as needed.

1111^- The TELAPI.EXE program and all programs that 
use TELAPI.EXE (such as, Host Presenter, 
third-party terminal emulators, TNVT220.EXE) let 
you open a maximum of ten sessions. However, the 
number of sessions you can actually open may 
depend on your system's configuration and usage.

Capturing Data from a Session

You can capture data from the remote host (induding the control 
characters sent by the remote host) and save this data in a file on 
your workstation. To do this, use the Capture command on the File 
menu. You can then review the text of the entire terminal session.

You can capture either the data in the terminal session buffer 
currently displayed on the screen, all the data stored in the 
terminal session buffer, or only the data sent by the remote host 
to your workstation between the time you start and end the 
capture session. You can also capture a specified number of 
characters.

To capture only the data in the terminal session buffer currently 
displayed on the screen, set the Amount to Capture field of the 
Capture command to Screen.
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To capture all of the data stored in the terminal session buffer, set 
the Amount to Capture field to Entire Buffer. The terminal 
session buffer can store up to the last 240 lines displayed. You can 
set the size of the buffer in the Emulator dialog box under the 
Setup menu.

To capture data sent by the remote host to your workstation, set 
the Amount to Capture field of the Capture command to 
Continuous. To end die capture, select Capture Off from the File 
menu.

To capture a specified number of characters, set the Amount to 
Capture field to Final and specify the number of characters you 
want to capture. Final places the data in a buffer. This buffer holds 
the number of characters that you specified, and always contains 
the most recent characters sent. To end the capture, select Capture 
Off from the File menu. When you end the capture, Host Presenter 
transfers the buffer to the file.

Characters that you capture as they are received by your 
workstation can be stored in one of the following modes:

• Untranslated text and graphic mode - Characters are 
saved in the remote host's display character set. This mode 
saves only text and graphic characters from the remote 
host. Use this mode to transfer text or graphics between 
remote hosts that require the same character set.

• Translated text and graphic mode - Characters are saved 
in the Windows display character set. Use this mode if the 
characters must be understood by other Windows 
programs.

• All Characters mode - Characters are saved in the remote 
host's display character set. This mode saves text and 
graphic characters and all command or control sequences 
from the remote host. Use this mode to confirm and debug 
command and control sequences.
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To capture data to a file on your workstation, follow these steps:

1. Select Capture from the File menu.

Capture

Amount to Capture Characters to Capture

O Einal

O Continuous 

©jScreen] 

O Entire Buffer

Characters O All Characters

O Untranslated Text/Graphics Chars 

© Translated Text/Graphics Chars

Capture Hie Name: CAXLN\HSTACC

OK Cancel Help

Hie to capture to (full path]

2. Select the Amount to Capture.

If you select Entire Buffer or Screen, you can only capture 
translated text and graphic characters.

If you select Continuous, you must also select a character 
mode from the Select Characters options.

If you select Final, also you must select a character mode 
from the Select Characters options, and enter the number 
of characters you want to capture in the text box.

3. Enter the name of the file for storing the captured text in 
the text box.

4. Click the OK button to start the text capture.

1111^ The process for capturing the Entire Buffer and 
Screen ends automatically. However, you must 
explicitly end the capture process for Continuous 
and Final.
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Printing from the buffer or 
the terminal screen

5. To end the capture process for Continuous and Final, pull 
down the File menu and select Capture Off.

1111^ When Continuous or Final capture is initiated, the 
Capture Off command replaces the Capture 
command in the File menu.

Printing Displayed Text

Host Presenter lets you print text directly to your printer from 
either the terminal scroll buffer, terminal screen, or selected area.

1111^ Before you print text, you must specify the appropriate 
printer in the Windows Setup program or in the Windows 
Control Panel.

To print text from the terminal scroll buffer or from the terminal 
screen, follow these steps:

1. Select Print from the File menu.

Print

How Much to Print

O Entire Buffer 

^IJermjnal Screen; 

O Selected Area

OK

Cancel

Help

Print Terminal Screen (last 24 lines of buffer)

2. Select either Entire Buffer or Terminal Screen.

3. Click the OK button to print.
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To print from a selected area, follow these steps:

1. Highlight the text that you want to print using your mouse.

2. Select Print from the File menu.

The Print dialog box appears.

3. Select Selected Area.

If you did not highlight an area of text, the Selected Area 
option appears gray, indicating it cannot be selected.

4. Click the OK button to print the selected area.

Printing from a selected 
area

Changing Fonts

You can change the font type and size displayed on the screen. To 
change the font, follow these steps:

1. From the terminal session, select Setup on the menu bar.

The Setup window appears.

2. Select Fonts from the Fonts menu.

Fonts

Font: 
System 
Courier 
Preview 
Terminal

The Fonts dialog box displays the current font type and 
size, and a list of available font types and sizes.
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Changing the font type and 
size from the Fonts menu

3. Select the font type and size you want to use.

Your selections appear as the current type and size in the 
Fonts dialog box.

4. Click the OK button to return to the Setup window.

5. Click the OK button in the Setup window to apply the new 
font type and size to the current terminal session.

You can also change the font type and size by pulling down the 
Fonts menu from the Setup window. To change the font type, 
select one of the listed fonts. To change the size, select either 
Enlarge Font or Reduce Font If no larger or smaller font is 
available, the selection is gray, indicating the option is not available.

Changing Text Colors

If you have a color monitor, you can select contrasting colors for 
a terminal session's text, bold text, and background. If you have a 
monochrome monitor, you can select only black or white for the 
text and background. Bold text is displayed as a thicker font 
automatically.

To change colors from the Terminal Session window, follow these 
steps:

1. From the terminal session window, select Setup from the 
menu bar.

2. The Setup window appears.
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3. Select the Colors menu.

The Terminal Color Selection dialog box displays the color 
selections for text, background, and bold text.

4. Select the colors you want for the text, bold text, and 
background by clicking the underlined arrow button at the 
right of each dialog box and then clicking on your choice 
in the list displayed.

1111^ If you want to use the specified colors for other 
Windows applications, click the Windows Default 
Colors check box.

5. Click the OK button in the Colors dialog box to return to 
the Setup window.

6. Click the OK button in the Setup window to apply the 
new colors to the current terminal session.

Changing the Display

Host Presenter lets you change the way text is displayed in the 
terminal session window on your workstation. If the window 
size set by the remote host is larger than the one displayed on 
your workstation, the text may be scrolled off the window and 
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you must use the scroll bar to read the hidden text. You can set 
the number of lines you can scroll by specifying the size of Host 
Presenter's terminal buffer. The buffer can contain a maximum of 
240 lines (including the lines displayed in the window). The 
ability to scroll is important if you perform repetitive tasks.

You can also change the cursor style. You can choose between a 
block or an underline style cursor.

To change the terminal window's display, follow these steps:

1. From the Terminal Session window, select Setup from the 
menu bar.

The Setup window appears.

2. Select Display from the Emulator menu.

Display Setup

Terminal Unes: E 

'Number of Columns 
® BO 0132

"Cursor Style-----------------
O Block @ Underline

Buffer Lines: 120

□ fiuto-wrap

0 Display Cursor

3. Select the number of lines you want to retain in the 
terminal session buffer.

1111^ The number of buffer lines must be equal to or 
greater than the number of terminal lines set by the 
remote host.

4. If you want to change the cursor, select either block or 
underline style.

5. Click the OK button in the Display Setup dialog box to 
return to the Setup window.
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6. Click the OK button in the Setup window to apply the 
new display parameters to the current terminal session.

Restoring the Default Profile Settings

If you changed any parameters in the terminal setup, you can 
restore the default profile settings.

To do so, follow these steps:

1. From the Terminal Session window, select Setup from the 
menu bar.

The Setup window appears.

2. From the Setup window, pull down the Profile menu and 
select Reset to Default Profile.

3. Click the OK button of the Setup window to restore the 
default profile settings.

The Terminal Session window will look and operate the way it 
did before you made any changes.

Creating a Profile

Host Presenter lets you create a profile file that opens a session to 
a remote host with the configuration settings (such as display 
fonts, screen colors, and column widths) specific to that host. To 
do this, you must first configure a terminal session, and then 
save the configuration in a profile file.

To create a profile file, follow these steps:

1. Select Setup from the menu bar.

The Setup Window appears.

2. Select a menu item you want to configure.

To configure more than one item, repeat this step.
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3. If you want this profile to become your default profile and 
appear every time you start Host Presenter, select Save as 
Default Profile from the Profile menu. (This saves the 
profile in the file DEFAULT.PHP.) Skip to Step 6.

If you do not want to save this profile as the default 
profile, select Save As Profile from the Profile menu.

The Save Profiles dialog text box appears.

4. Type a name for the profile in the Filename text box. If 
necessary, choose a directory for the profile from the 
Directories list box.

5. Click the OK button to return to the Setup dialog box.

6. If you want to run the new profile and immediately log in 
to that remote host, click the OK button. If you want to 
return to the terminal session window without running 
the profile, click the Cancel button.

Running a Script File

Script files are text files that contain a series of commands. When 
you give a script to a script processor, it executes the commands 
in the script. For example, you can write a script file that 
automatically logs you in to a remote host or updates a file at an 
assigned time. Script files for the Host Presenter program are 
written in the ScreenPlay script language, and are processed by 
the Script Director script processor. Refer to the LAN Workplace 
for DOS Administrator's Guide for information about writing a 
script file and for the definition of the ScreenPlay script language.
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To run a ScreenPlay script file, follow these steps:

1. From the Terminal Session window, Select Run Script 
from the File menu.

Run Script

Bun

£ancelScripts:

File:

Current Dir: cAxln\hstacc

Directory:

Help

Directory to search for Scripts

2. Either type the name of the script file in the text box or 
select the script file from the list box.

3. Click the Run button to return to the Script Director 
window.

If the Script Director does not find any errors, it runs the 
script. Otherwise, the Script Director reports the error to 
you and does not run the script.

You can pause or cancel the script while it is running. To pause 
the script, click the Pause button in the Script Director window. 
To continue, click the Continue button. To cancel the script, click 
the Cancel button in the Script Director window.

Pausing or canceling a 
running script

Using Logon Scripts

A logon script is a script containing a set of commands that you 
want executed when you connect to a remote host. Host 
Presenter lets you run a logon script automatically each time you 
start the Host Presenter program. For example, a logon script can 
send your user name and password to a remote host
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automatically, after you establish a connection. You can run a 
logon script from any profile file, including the default profile.

For more information on creating logon scripts, refer to the LAN 
Workplace for DOS Administrator's Guide.

Selecting a Logon Script
You can select a logon script in the Setup dialog box to use with a 
profile. To do this, follow these steps:

1. Select Open Profile from the Profiles menu and open the 
profile to which you want to add a logon script.

2. Select Logon Scripts from the Scripts menu.

3. Select Select Logon Script from the cascade menu.

4. Select the logon script from the Logon Script dialog box.

5. Click the OK button to return to the Setup dialog box.

6. If you want to run the new profile and log in to that remote 
host, click the OK button. If you want to return to the 
terminal session window without running the profile, click 
the Cancel button.

After completing Step 6, the logon script that you selected will 
run automatically when you use that profile.

Clearing a Logon Script
You can clear a logon script from a profile by using the Setup 
dialog box.

1. Select Open Profile from the Profiles menu and open the 
profile from which you want to clear a logon script.

2. Select Logon Scripts from the Scripts menu.

3. Select Clear Selected Logon Script from the cascade menu 
to remove the logon script from the profile.

4. Click the OK button to return to the Setup dialog box.
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5. If you want to run the new profile and log on to that remote 
host, click the OK button. If you want to return to the 
terminal session window without running the profile, click 
the Cancel button..

After completing Step 5, the logon script is cleared from 
the profile.

Attaching a Script File to a Key

You can attach ScreenPlay script files to the shortcut keys Alt-0 
through Alt-9. After attaching it to a shortcut key, you can run the 
script file by pressing the specified shortcut key.

To attach a ScreenPlay script file to a shortcut key, follow these 
steps:

1. From the Terminal Session window, select Setup from the 
menu bar.

The Setup window appears.

2. Pull down the Scripts menu and select Script Keys.

Script Keys

Attach Script..

QjÄiräi No script attached

O ALT-2: No script attached

O ALT-3: No script attached

O ALT-4: No script attached

O ALT-5: No script attached

0 ALT-5: No script attached

O ALT-Z: No script attached
O ALT-8: No script attached
O ALT-2: No script attached

O ALT-5: No script attached

Detach Script

OK

Cancel

Help...
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3. Select a shortcut key.

4. Click the Attach Script button.

Attach Script to ALT-1

f.SHP

cAxln\bin

files: directories:

Script Hame:

Directory:

H 3w ■
hH
hH V

5. Either type the name of the ScreenPlay script file you want 
to attach in the text box or select a file name using the 
directory and file list boxes.

6. Click the OK button to return to the Script dialog box.

The name of the ScreenPlay script file appears next to the 
shortcut key.

7. Click the OK button to attach the ScreenPlay script file to 
the shortcut key and return to the Setup window.

8. Click the OK button to apply the change to the current 
terminal session.

Detaching a Script File from a Key

Before you can reassign a shortcut key, you must detach the 
current ScreenPlay script from the shortcut key.

To do so, follow these steps:

1. From the Terminal Session window, Select Setup from the 
menu bar.
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The Setup window appears.

2. Select Script Keys from the Scripts menu.

The Script Keys dialog box appears.

3. Select the shortcut key you want to detach from a 
ScreenPlay script file.

4. Click the Detach Script button to detach the script.

"No Script attached" is displayed next to the shortcut key.

5. Click the OK button to return to the Setup window.

6. Click the OK button to apply the change to the current 
terminal session.

Using National Terminal Types

Host Presenter supports many language terminal types. 
Multi-language support increases the flexibility of the Host 
Presenter program because you can use the same terminal 
emulation program to communicate with remote hosts in 
different countries.

To change to another nation's terminal type, follow these steps:

1. From the Terminal Session window, select Setup from the 
menu bar.

The Setup window appears.
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2. From the Setup window, select Emulation from the 
Emulator menu.

Emulation Setup

"Emulator Type National Terminal: OK
O VT-52 O vr-100 

1^220.'Pbit

O VT-220. fi-bh

French 
German Austrian 
Kalian 

[Multinational I ■
Cancel

Help...
■ North American □

3. Select the national terminal type that you want to use.

4. Click the OK button in the Emulation Setup dialog box to 
return to the Setup window.

5. Click the OK button in the Setup window to apply the 
new national terminal type to the current terminal session.
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4
TRANSFERRING FILES USING FILE EXPRESS

TM
The File Express program is a Microsoft Windows 3.0 
application that lets users at DOS workstations transfer files 
between network computers. This includes computers on the 
local network as well as any computer on remote networks with 
connections to the local network. File Express uses the File 
Transfer Protocol (FTP) to transfer files between systems that 
support FfE

Before you begin using File Express, you should be familiar with 
Microsoft Windows 3.0, because these operations are integrated 
into the File Express program. You should know how to perform 
the following operations:

• Open Microsoft Windows on your workstation

• Open application programs under Microsoft Windows

• Stop an application program

In addition, you should know how to use the mouse and 
keyboard to perform the following Windows operations:

• Select menus and menu items, command and option 
buttons, and check boxes

• Select items in windows, dialog boxes, and list boxes

• Mark and select text

• Reduce a window to ah icon and restore it

• Move and size windows

Refer to the Microsoft Windows User's Guide for information on the 
operation of Microsoft Windows.
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Overview of File Express

You can use File Express to connect to, and copy files between, 
two file systems. A file system is a collection of files you can 
access from a common point. A local file system can be the C: 
drive on your workstation's hard disk; a remote file system can 
be a minidisk on an IBM VM system or a directory tree on a 
UNIX system. A Network File System (NFS) can appear to be 
either local or remote. If NFS is mounted on a VM or UNIX 
system, it will appear to be another directory on that remote 
system. If NFS is mounted on your DOS workstation, it will 
appear to be another local file system.

You can copy files between file systems on the following:

• Your workstation and a remote host

• Two remote hosts

• One remote host

• Your workstation

When you use File Express to connect to two file systems, the 
contents of each file system are shown in the display windows. 
Each file in the system normally appears as an icon (indicating 
the file type) followed by the name of the file. You can copy files 
between file systems by selecting files in one window and 
clicking the Copy button. This copies them to the other window.

Getting Help

If you need information about file transfer parameters or one of 
the menu items, File Express provides an online help system. The 
online help information is arranged in a topic index, listing the 
available help topics. The help information initially displayed 
depends on which window is active when you open the help 
system.
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To open the help system from the File Express window, follow 
these steps: Opening the help system 

from the File Express

1. Pull down the Help menu.

2. Select the Index menu item or the topic.

window

The help system displays the index or information about 
the topic selected.

To open the help system from a dialog box, click the dialog box's 
Help button. The help system displays information about the 
dialog box.

For help on the help system, pull down the Help menu and select 
Using Help. Using Help describes help basics, help menu items, 
and how to use the help system.

Opening the help system 
from a dialog box

Basic Tasks

To connect to two file systems and copy files, you must complete 
certain basic tasks. File Express lets you perform the following 
basic tasks:

• Open the File Express program

• Copy files

• Display files within a file system

• Close a session

• Open other sessions

• Use shortcut keys

• Exit from the File Express program

This section discusses these basic tasks.
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Opening File Express

Before you can open the File Express program, TCP must be 
loaded. If you requested the installation program to modify your 
AUTOEXEC.BAT file, TCP is automatically loaded when you 
start your workstation. Otherwise, you must manually load TCP 
before loading Windows 3.0.

To open File Express, follow these steps:

DOD 
DOD

LAN Workplace

1. Double-click on the LAN Workplace icon in the Windows 
3.0 Program Manager to open the LAN Workplace 
program group window.

Fie Express

2. Double-click the File Express icon to display the File 
Express window that is similar to the following:

S FileExpress - (c:)H □Ol
file Edit View Options Profile Help

cAxin\bin
0 filcxprs.exe 0 ipx.com Info

0 arp.exe 0 ftp.exc 0 key220.exe
0 bstatexe 0 ftpd.exe 0 key3270.exe
0 exosid.exe 0 ftpserv.bat 0 nb.bat

Erint

Rename
| + —.......

copy

Delete

Close

When you open the File Express program, it automatically 
connects to the local file system containing the File Express 
program, displays the file names in its upper list window.
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If File Express is not set up to load a profile that opens two 
files systems automatically, the Open a Remote File System 
dialog box appears.

Open a Remote File System

You can create a local profile which displays selected local 
DOS file systems only. Refer to the LAN Workplace for DOS 
Administrator's Guide for information on creating File 
Express profiles.

You can open a session with a remote file system by filling 
in the requested information in the dialog box or a local 
file system (on your workstation) by canceling this dialog 
box and opening a session with a local file system.

1111^ You cannot enter characters with ASCII values 
below decimal 32 or above decimal 127 in text 
boxes. Therefore, do not include them in filenames 
or passwords.

3. Click the Remote Host Name text box and type the name 
of the remote host.

4. Click the User Name text box and type your user name.

5. If the remote host requires a password, click the Password 
text box and type your password.
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For security purposes, the text box displays an asterisk 
(the * character) for each character in your password.

6. Click the Initial Directory text box and type the name of 
the initial directory or minidisk you want to display.

When File Express opens a session to the remote host, the 
name of the initial directory you specified is displayed in a 
list window.

7. If the operating system on the remote host requires an 
account name, click the Account text box and type the name.

Some operating systems require an account password 
before you can access file systems. (For VM, you must type 
the read/write password in the Account text box.)

8. Select the operating system used by the remote host.

9. Click the Open button or press the Enter key.

File Express connects you to the specified file system. The 
Open a Remote File System dialog box disappears, and 
displays the files in the lower list window.

Q FileExpress - (g:|(solar.stanford.edu:) □E
Eile £dit yiew Options Profile Help _________ ____________

g.^userViaie^work 
□ >77^/7747^ [3 unix2dos.pfx
B backup.bat 3 unixlocl.php

filelisttxt Q rates.wk3
cntrctl .wri 3 forecastpcx

0 schedule.doc

Info

Print

Rename

solar.stanford.edu: /news.90
Copy

B 5.may [23 9.sep Qelcte
[5 2.feb H B.jun
3 3.mar (25 7.Jul
B 4-aPr 3 8 ®ug

Close
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Copying Files

You can copy files between the following file systems, regardless 
of the type of system:

• Local to remote

• Remote to local

• Remote to remote

• Local to local

To do this, you must open two sessions, one session to the file 
system containing the file you want to copy and one session to the 
destination file system.

The contents of each file system are listed in windows. The files 
in a file system can be either listed by file name or displayed as 
an icon (indicating the file type), followed by the file name. One 
list window displays the files you want to copy and the one 
displays the destination file system. By selecting the files you 
want to copy in one window and clicking the Copy button, you 
can copy them to the other window.
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To copy files between two file systems, follow these steps:

1. Select the file or files that you want to copy.

To copy files, select the 
files and dick the Copy 
button.

sizing box

sizing bar

scroll box

Icon Types 
directory:
□ dos

executable program:
3 chkdsk.com

word processing file:
rcadme.doc

plain text file:
rcadme.txt

LWP profile file:
[SI a.php

spreadsheet file:
H«.wk3

other file type:
Q finish.pcx

You can select one file by clicking it with the mouse, or 
select more than one file by holding down the Shift key 
while clicking on the desired files.

If the list window does not display all the files that you 
want to copy, you can either enlaige the window, scroll the 
window, or both.

To enlarge the window, move the pointer to the sizing box on 
the left-hand side of the window, hold down the left mouse 
button, and move the mouse. Moving the sizing box towards 
the bottom of the screen enlarges the upper list window. 
Moving the sizing box towards the top of the screen enlarges 
the lower list window.

To scroll the window to display more files, move the 
pointer to the scroll box at the bottom of the list window, 
hold down the left mouse button, and move the mouse.
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2. Click the Copy button.

The files are copied to the other file system and displayed 
in its list window.

Displaying Files within a File System

The list window for a particular file system may not display ail 
the files in the file system. You can display other files in all file 
systems using the following methods:

• Sizing the list window - Move the sizing bar between the 
windows up or down to change the relative size of the two 
list windows. To enlarge the window, move the pointer 
onto the sizing box on the left-hand side of the window or 
onto the sizing bar between the windows, hold down the 
left mouse button, and move the mouse. Moving the sizing 
box or bar towards the bottom of the screen enlarges the 
upper list window. Moving the sizing box or bar towards 
the top of the screen enlarges the lower list window.

• Scrolling the list window - Move the scroll box in either 
list window left or right to display other files. To scroll the 
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window, move the pointer onto the scroll box at the 
bottom of the list window, hold down the left mouse 
button, and move the mouse.

If the file system has a hierarchical or tree structure, such as DOS 
or UNIX, you can also use the following three methods to display 
other parts of the file system:

• Select the Change Directory command on the File menu - 
Type the name of the directory that you want to display 
in the text box. If you opened a DOS file system, you can 
type the name of the drive, the directory path, or both.

• Double-click a directory icon - Double-click on a 
directory icon to move to that directory and display the list 
of files in that directory. This operation moves down in the 
directory structure, away from the root directory (\ in 
DOS or / in UNIX).

• Select part of the displayed directory name - List 
windows for hierarchical file systems display the current 
working directory name for the file system (at the top of 
the list window). Double-click a part of the name with 
your mouse. The list window displays the directory 
corresponding to the name, up to and including the 
portion that you clicked. This operation moves up in the 
directory structure, towards the root directory (\ in DOS 
or / in UNIX).

If the list window has the following current working 
directory at the top of the window:

f:\user\james\save

and you move the pointer over james and double-click: 

f:\user\ja^s\save

the list window then displays the following directory: 

f:\user\james

The last two methods are the graphical equivalents of the DOS or 
UNIX cd (Change Directory) command.
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Closing a Session

When you want to copy files, you may need to dose a current 
session before opening a new one to the remote host or your 
workstation.

To close a session, follow these steps:

1. Make sure the window you want to close is the active one.

The Windows Active Border Color (that you set in your 
Windows Control Panel) identifies the active list window. 
If the window you want to close is not the active window, 
move the pointer to it and click.

2. Click the Close button to close the active session.

1111^ If you have a small File Express window, all the 
buttons may not appear in the window. If the Close 
button is not visible, pull down the File menu and 
select Close Active File System.

Opening Other Sessions

In addition to copying files between your workstation and a remote 
host, you can also copy files between two remote hosts, or between 
two directories on the same remote host or on your workstation. 
Before you can do this, you may need to close one or both open 
sessions, and then start sessions with the desired file systems.

Opening Sessions With Two Remote Hosts
To open sessions with two remote hosts, follow these steps:

1. If necessary, close any active sessions with local file systems, 
as described in the previous section Cosing a Session.

2. Select Open a Remote File System from the File menu.

The Open a Remote File System dialog box appears.

3. Type the host name in the Remote Host Name text box.
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4. Click the User Name text box and type your usemame.

5. If the remote host requires a password, click the Password 
text box and type your password.

For security, the text box displays an asterisk (the * 
character) for every character in your password.

IIIU^ Because you cannot enter characters with ASCII 
values below decimal 32 or above decimal 127 in 
text boxes, do not include them in passwords.

6. Click the Initial Directory text box and type the initial 
pathname that you want to display on the remote host.

7. If the operating system on the remote host requires an 
account name, click the Account text box and type the name.

Some operating systems, such as VM, require an account 
password before you can access file systems on the system. 
For VM, type the read/write password (to the initial mini­
disk) in the Account text box.

8. Click the operating system used by the remote host.

9. Click the Open button.

File Express connects you to the specified file system and 
displays the name of the file system in the list window.

To open a session with the second remote host, repeat steps 2 
through 9.

You can now transfer files between remote hosts using the 
procedure described in the section Copying Files, earlier in this 
chapter.
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Opening Sessions with Two Local File Systems
To open sessions with two local file systems on your workstation, 
follow these steps:

1. If necessary, close any active remote sessions, as described 
in the section Closing a Session earlier in this chapter.

2. Select Open Local File System from the File menu.

Path:

Open the Local DOS File System

Open Cancel Help...

3. Click the Path text box and type the path.

This is a path to the directory that you want to display in 
the list window. A path for a DOS file system consists of 
the drive name followed by the directory path (for 
example, CABIN).

4. Click the Open button.

To open a session with another local file system, repeat Steps 2 
through 4.

You can now transfer files between the two local file systems 
using the procedure described in the section Copying Files, 
earlier in this chapter.
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Table 4*1
Shortcut Keys

Using Shortcut Keys

The File Express program uses shortcut keys to move the cursor 
within a file system, switch the active list window, resize the file 
system windows, and select files or directories within a file 
system. The shortcut keys and the function they perform are 
listed in Table 4-1.

Shortcut Key Function

Down arrow Move the cursor to the next item. If at the end of a column in a 
multicolumn list, the cursor moves to the top of the next column.

Up arrow Move the cursor to the previous item. If at the top of a column in a 
multicolumn list, the cursor moves to the bottom of the preceding 
column.

Right arrow Move the cursor to the next column.

Left arrow Move the cursor to the previous column.

Home Move the cursor to the first item in the list.

End Move the cursor to the last item in the list.

PgDn Scroll the display window down when the View menu is set to the 
detailed display mode.

PgUp Scroll the display window up when the View menu is set to the detailed 
display mode.

Ctrl-PgDn Scroll right when the View menu is set to the brief display mode.

Ctrl-PgUp Scroll left when the View menu is set to the brief display mode. The 
brief display mode displays only the file and directory names.

F2 Move the divider bar up or down, increasing or decreasing the size of 
the two display windows. The shortcut key sequence is: press F2 to 
select the divider bar, move divider bar using the up or down arrow 
keys, and press F2 again to set the divider bar's position.
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Table 4-1
Shortcut Keys (Continued)

Shortcut Key Function

Ctrl-F6 Switch which display window is the active window.

Arrow key Select a single file by highlighting the file name.

Shift key+arrow key Select multiple files. Hold down the Shift key while moving the cursor 
using the arrow keys.

Space bar Remove the highlighting from a file in multiple file list. Hold the Shift 
key down, move the dotted box to a selected file using the arrow keys, 
and press the Space bar.

Exiting File Express

You do not need to close the open sessions before exiting File 
Express. To exit from the File Express program, use either of the 
following methods:

• Select Exit from the File menu

• Click the Control-menu box to open the Control-menu 
window and select Close

Advanced Tasks

This section discusses the following advanced tasks you can 
perform using the File Express Program:

• Search for files

• Copy record files

• Copy a directory tree
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• Create a directory

• Rename files and directories

• Print files

• Delete files

• Get information about files

Searching for Files

If you have a file system containing many directories, files can be 
difficult to locate. The file transfer program has a search function 
that helps you locate files.

To find a file, follow these steps:

1. Select Search from the File menu.

Search for Files - (Source: c:\)

"Selected Flics 
telagentexe 
telapi.exe

""Select Additional Hies

telagentexe

<< Add To Selections

fiemove From Selections

Start Search At:

Search Cancel Help...

2. Click the Select Additional Files text box and type the 
name of the file that you want find.
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3. Click the Add to Selections button.

The file name is displayed in the Selected Files list box. 
Repeat the Steps 2 and 3 to add additional files.

To remove a file from the list of selected files, highlight the 
file and click the Remove from Selections button.

4. If you want the search to start from a directory other than 
the currently displayed directory, click the Start Search At 
text box and enter a directory name.

5. Click the Search button.

Search Results

Found A occurrences.

cAnewtcp\telapi.exe 
c-Axin\bin\telagent.exe 
cAxinVbin\telapi.exe 
c^xin\h sta cc\tel api. exe

Gi> Td Cancel Help...

File Express displays the name of the directories being 
searched. At the end of the search, it displays the number 
of files found and lists the file pathnames in a dialog box. 
If none is found, the Search Results window displays 
"Found 0 occurrences."

6. If you want to display that directory in the list window, 
select a filename and click the Go To button .

If you want to return to the list window for the file system 
without changing directories, double-click the 
Control-menu box in the upper left-hand comer of the 
Search Results window.
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Copying Record Files

If you are transferring non-record files and if the remote host is not 
VM, MVS, or Other, the File Express program automatically 
determines whether the file being transferred is ASCII text or binary. 
The Program Determines Hie Type Option is the default mode.

If you are transferring record files or if the remote host is VM, 
VMS, or Other, follow the steps below to disable this option and 
specify the file type and structure:

1. Select Transfer Options fromthe Options menu.

FrPTransfcrOptions

Host c8.excelan.com 
Operating System: UNIX 
Format non-print 
Mode: stream

"Connection Options

□ Program determines File Type 
Type: O ASCII Binary
Structure: Q Rie ^jRecordi 

□ Local Byte £ [tenex] 

ßj Program Selects HP Port 

IS Determine if File or Directory by

Save As Default

a Directory List

2. Click the Program Determines File Type check box to 
disable the file-type checking.

3. Click the Binary option button to select the binary file 
type.

4. Click the Record option button to select the record file 
structure.

5. Click the OK button to return to the File Express window.

After completing Step 5 you can select files and copy them, as 
described in the section Copying Files earlier in this chapter.
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Copying a Directory Tree

File Express lets you copy a directory recursively. This means you 
can copy a directory tree (including all of its subdirectories and 
files) between hierarchical file systems.

To copy a directoryrecursively, follow these steps:

1. Open connections to both file systems.

1111^ The file system that is receiving the copy must also 
be a hierarchical file system.

2. Select Applications Options from the Options menu.

Application Options

‘Copy Options----------------------------------
SI Be cursive I y Copy Directory Trees 

Howto Handle Illegal DOS Names:
O Automatically Rename 

O Prompt for New Name 

® Skip any Illegal Names

’ Pro m pt Fo r-------------------------------------  

® Confirmation on Delete

‘Active Display Window Options 

Maximum File Name Length:

"Display Options

® Display File Type Bitmaps

OK Cancel Help...

3. Click the Recursively Copy Directory Trees check box.

The file transfer program marks the check box.

4. Click the OK button to return to the File Express window.

5. Select the directory you want to copy.

6. Click the Copy button to copy the directory tree to the 
destination window.
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Creating a Directory

File Express lets you create directories in any of the currently 
connected file systems.

To create a directory, follow these steps:

1. Click the list window containing the file system where you 
want to create the new directory.

2. Select Create Directory from the File menu.

Path:

Create a New Directory

Make Cancel Help...

3. Enter the path and directory name in the text box.

4. Click the Make button to create the directory in the 
selected file system.

Renaming Files and Directories

File Express lets you rename a file or directory. The directories or 
files you rename must be in one of the file systems to which you 
are connected and the new names must conform to the naming 
conventions for that file system.
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To rename files or directories from a single list window, follow 
these steps:

1. From the list window, select one or more files or 
directories that you want to rename.

2. Click the Rename button.

3. Type the new name in the text box.

4. If the new name is correct, click the Yes button.

File Express renames the file or directory. The dialog box 
reappears, and you repeat Steps 3 and 4 for each file that 
you listed.

If you do not want to rename the specified file or directory, 
click the No button.

If you want to cancel the renaming procedure, click the 
Cancel button.

At the end of the list the dialog box disappears, leaving you in 
the File Express window. The files you renamed are displayed 
with their new names.
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If the files that you want to rename are in different list windows, 
use the following procedure:

1. Select Rename from the File menu.

Rename Files - (Source: c:\xln\bin)

r Selected Files "Select Additional Files
\newtcptyelapi.exe
Vdnyistaccttelapi.exe \newtcpMelapi.exe

« Add To Selections

Remove From Selections

Rename Cancel Help...

2. Click the Select Additional Files text box and type the 
name of a file or directory that you want to rename.

3. Click the Add to Selections button.

Repeat Steps 2 and 3 to add additional files or directories.

4. Click the Rename button.

File Express displays a Rename Files confirmation box for 
each file in the list.

5. Type the new name for the file or directory.

6. Click the Yes button to rename the file or directory.

File Express renames the file or directory. The confirmation 
box reappears, and you repeat Steps 5 and 6 for all the files 
that you listed.

If you do not want to rename the specified file or directory, 
click the No button.
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If you want to cancel the renaming procedure, click the 
Cancel button.

At the end of the list the dialog box disappears, leaving you in 
the File Express window. The renamed files are displayed with 
their new names.

Printing Files

You can use File Express to print files. However, before you can 
print, you must install and configure the appropriate printer in 
the Windows Setup program or in the Windows Control Panel.

Illl^ The PRINT command assumes the files are ASCII text files 
and converts them to DOS format before printing. 
However, some files on remote hosts (such as EBCDIC text 
files on an MVS host) may not print properly.

To print files from a single list window, follow these steps:

1. From the list window, select one or more files that you 
want to print.

2. Click the Print button.

File Express displays a message box for each file it sends to the 
printer. If you want to cancel printing, click the Cancel button.
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If the files that you want to print are in different list windows, 
use the following procedure:

1. Select Print from the File menu.

Print Files - (Source: c:\xln\bin)

Selected Flies 
nb.bat

Select Additional Files

<< Add To Selections

fiemove From Selections

Print Cancel Help...

2. Click the Select Additional Files text box and type the 
name of any additional file that you want to print.

3. Click the Add to Selections button.

Repeat Steps 2 and 3 to add additional files.

4. Click the Print button.

File Express sends the files to the printer. If you want to cancel 
printing, click the Cancel button.

At the end of the list the dialog box disappears, leaving you in 
the File Express window.
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Deleting Files

File Express lets you delete one or more files from a file system.

To delete files from a single list window, follow these steps:

1. Select one or more files that you want to delete from the 
list of file names in the list window.

2. Click the Delete button.

3. Click the Yes button to delete the file.

If you do not want to delete the file, click the No button.

If you want to cancel the deletion procedure, click the 
Cancel button.

The confirmation box reappears for each file listed.
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If the files that you want to delete are in different list windows, 
use the following procedure:

1. Select Delete from the File menu.

Delete Files - (Source: c:\xln\bin)

Selected Rics
\newtcpUelapi.exe
VdnVistacc\telapi.exe

"Select Additional Hies

\newtcp\telapi.exe

<< Add To Selections

Bemove From Selections

Delete Cancel Help...

2. Click the Select Additional Files text box and type the 
name of the file that you want to delete.

3. Click the Add To Selections button.

Repeat Steps 2 and 3 to add additional files.

4. Click the Delete button.

File Express displays a confirmation box for each file.
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5. Click the Yes button to delete the file.

If want to keep the file, click the No button.

If’you want to cancel the deletion procedure, click the 
Cancel button.

At the end of the list, File Express redisplays its main window 
and names of the deleted files are no longer displayed.

Getting Information About Files

File Express lets you display information about one or more files. 
The information displayed depends on the type of file and the 
information received from the remote host. The file information 
might include the filename, size, protection, and the date and 
time the file was opened previously.

To display information about one or more files in a single list 
window, follow these steps:

1. Select the files from the list box.

2. Click the Info button to display information similar to the 
following:

Get File Information
teltbl1.doc 4096 3-27-90 11:07
teltbl2.doc 6016 3-27-90 11:23
teltbl21 .doc 896 5-01-89 14:05
teltbl3.doc 5760 1-24-90 11:11
teltbl4.doc 1408 3-27-90 10:58
teltbl4a.doc 1408 12-11-89 7:07
teltbl5.doc 1664 1-24-90 11:05
teltbl6.doc 4992 3-27-90 11:23
teltbI7.doc 5888 3-27-90 11:23
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3. Double-click the Control-menu box in the upper left-hand 
comer of the window to close the window.

The list window disappears, leaving you in the File 
Express window.

If the files about which you want information are in different list 
windows, use the following procedure:

1. Select Get Info from the File menu.

Get File Information - (Source: c:\xln\bin)

"Selected Files
\newtcp\telapi.exe 
VdnKbinyelapi.exe
Vd n\h staccato I a p I. exe

Select Additional Files

Vdn\hstacc\telapi.exe

« Add To Selections

Qemove From Selections

Info Cancel Help...

2. Click the Select Additional Files text box and type the 
name of the file about which you want information.

3. Click the Add To Selections button.

Repeat Steps 2 and 3 to add additional files.

4. Click the Info button.

The program displays a window with information about 
each file in the list.

5. Double-click the Control-menu box in the upper left-hand 
comer of the window to close the window.

The list window disappears, leaving you in the File 
Express window.
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The Serving Fir is an FTP server program that lets other network 
users archive or access files on your workstation. You can make your 
workstation an FTP file server by running the Serving FTP program. 
When your workstation is running Serving FTP, any network 
computer running an FTP client program can access your workstation 
and transfer files to or from it

When you run Serving FTP, your workstation does not become a 
dedicated file server. Serving FTP runs in its own window in the 
background and you can run other applications simultaneously. 
Although the Serving FTP program supports only one FTP 
session at a time, when a session ends, Serving FTP continues to 
run and waits for other session requests.

Opening a Serving FTP Session

Before you can open the Serving FTP session, TCP must be running 
on your workstation. If you requested the installation program to 
modify your AUTOEXEC.BAT file, TCP is loaded automatically 
when you start your workstation. Otherwise, you must load TCP 
before loading Windows 3.0.

You can open a Serving FTP session using double-clicking the 
Serving FTP icon. You can also open a Serving FT P session 
automatically when you start Windows by adding the name of 
the executable file, SERVEFTP.EXE, to the load= line in the 
[windows] section of the WIN.INI file as follows:

load=wftpd.exe other_executable_files

Serving FTP

Opening a Serving FTP Session 5-1
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Restricting Access to Your Workstation

The Serving FTP program has its own authorization system to let 
you restrict access to the files on your workstation. To do this you 
must create the file \XU'J\HSTACC\FTPDUSR.LOG and list the 
users authorized to access your files. Only the users listed in this 
file can log in to Serving FTP on your workstation.

When a network user tries to open an FTP connection to your 
workstation, Serving Fir checks for the user name entry in 
FTPDUSR.LOG. Each entry in the FTPDUSR.LOG file consists of 
a single line in the following format:

user_name [-.password]

user_name is the name of the user.

password is an optional password for that user.

user_name and password are not case-sensitive. Neither can 
contain spaces or tab characters and they must be separated by a 
colon with no spaces.

If this file does not exist, any computer on the network with an 
FIF client (such as FI EEXE or File Express) can access the files 
on your workstation.

Creating a Log File

You can create a log file to record all the FTP transactions 
serviced by Serving FTP. A log file is a text file that records the 
name of the user requesting the service, the time the user logged 
in and out, and the Fir commands executed by the user.
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To create a log file, follow these steps:

1. Double-click the Serving FTP icon.

2. Select Log from the File menu.

Open Log File

Filename: wftpdlog.txt

Directory: c.*\xlnVistacc

Dies: ßirc dories:
Destination

□ Log To Screen

© Overwrite File

O Append to file

Ok Cancel

3. Select an existing log file or create a new one.

The default log file is \Xm\HSTACC\V\TTPDLOG.TXT.
You can log transactions to another file by typing another 
name in the text box or selecting a file from the list box.
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You can also send the FTP transactions to the Serving FTP 
window by clicking the Log to Screen check box. Serving 
FTP then records the FTP transactions in the specified log 
file and displays them in the Serving FTP window.

4. Click the OK button to start logging transactions.

The Log entry in the File menu shows a check mark beside 
it while transactions are being logged to a file.

File
fiesolve Client IP Address... 

V Log-
Status...
£lose Session
Exit
A^out..

To stop recording FTP transactions, pull down the File menu and 
select the checked Log entry. Serving FTP stops logging 
transactions, and the check mark no longer appears on the menu.

Checking Serving FTP Status

You can check the status of Serving FTP on your workstation. 
The status can be either active or inactive. If active, a status check 
displays the name of the user and the name and IP address of the 
remote computer connected to your workstation. The IP address 
is displayed in dotted notation.

To check Serving FTP status, follow these steps:

1. Double-click the Serving FTP icon to display the Serving 
FTP window.
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2. Pull down the File menu and select Status.

The Status message box displays either a Session Inactive 
or Session Active message. If Serving FTP is active, the 
message lists the IP address of the remote computer and 
the name of the user on that remote computer.

3. Click the OK button to close the Status message box.

Closing a Serving FTP Session

You can close a Serving FTP session and either leave Serving FTP 
running or exit the Serving FTP program. To close a Serving FTP 
session use either of the following methods:

• Close the current Serving FTP session but leave Serving 
FTP running. To do this, pull down the File menu and 
select Close Session. Any authorized user can now open a 
Serving F TP session with your workstation.

• Close the Serving FTP session and exit Serving FTP. To do 
this, pull down the File menu and select Exit.

1111^ Neither method informs the remote user that the 
FTP session is about to end. If a user is connected to 
your workstation when you close the FTP session, 
the user's session is closed without warning.
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USING YOUR WORKSTATION AS A TERMINAL

The LAN Workplace software provides the TNVT220 terminal 
emulation utility that runs under standard DOS. The TNVT220 
utility lets your workstation emulate a DEC VT220, VT100, or VT52 
terminal directly connected to a remote host.

A terminal emulator lets you log in to a remote host as if you are 
using a terminal directly connected to the remote host. After you 
log in, you can execute any commands and perform any 
operations that the remote host supports. The TNVT220 utility 
accesses the services of Telnet clients on other computers via the 
Telnet Application Program Interface (TelAPI).

The LAN Workplace software also provides the Telnet Session 
Utility (TSU) that lets you use network-compatible third-party 
terminal emulators via TelAPI.

Illl^ To connect to a remote host with TNVT220 or TSU, the 
remote host must be running a Telnet server program.

Using the TNVT220 Terminal Emulator

The TNVT220 terminal emulation utility lets your workstation 
emulate a DEC VT220, VT100, or VT52 terminal directly connected 
to a remote host. This section explains how to use the 
TNVT220 utility.
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Starting TNVT220

To start TNVT220, follow these steps:

1. If not already loaded, load TelAPI by entering the 
following command at the DOS prompt:

C> TELAPI

A message similar to this is displayed:

TELAPI - Copyright © 1990 Novell, Inc. LAN Workplace for DOS

Number of Sessions: 2
Number of Stacks: 1

Refer to the LAN Workplace for DOS Administrator's Guide for 
information on the TelAPI options.

If you requested the installation program to modify your 
AUTOEXEC.BAT file, TelAPI is automatically loaded 
when you start your workstation.

2. Start TNVT220 by entering a command in the following 
format at the DOS prompt:

C> TNVT220 [ remote_host]

If you omit remotejiost, you enter command mode. The 
system displays the TNVT220> prompt and you can perform 
any TNVT220 commands.

If you specify remotejiost, you enter terminal mode. 
TNVT220 prompts you to log in then establishes a session to 
that host. The remote host's system prompt is displayed. You 
can now execute any command that the remote 
host understands.
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Status Line

When you establish a TNVT220 session with a remote host, 
TNVT220 displays a status line at the bottom of your screen, if 
the following are true:

• You are emulating a VT52, VT100, or VT220 terminal.

• You did not tum the status line off the last time you were 
in TNVT220 setup mode.

• You did not open TNVT220 with the -X option.

Figure 6-1 shows how TNVT220 displays information on the 
status line. Each part is explained below:

• TNVT220 - Novell, Inc. - TNVT220 product identification.

• remote host - First 19 characters of the remote host's name 
or IP address.

• # - Current session ID.

• mode - Indicate whether the terminal emulator is in 
replace (Rep) or insert (Ins) mode.

• time - Current time on your workstation.

• A (caret) - Displayed when you press the Ctrl key.

• T (up-arrow) - Displayed when you press the Shift key.

• A - Displayed when you press the Alt key.

• N - Displayed when Num Lock is on.

• C - Displayed when Caps Lock or Shift Lock is on.

• H - Displayed when Scroll Lock is on. (This is equivalent 
to Hold Screen.)

TNVT220 - Novell, Inc. remote_host (it) mode time * T ANCH

Figure 6-1
TNVT220 Status Line
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Establishing Multiple Sessions

TNVT220 lets you establish up to 10 sessions with the same host or 
with different hosts. To establish multiple sessions, start TNVT220 
(as described in the section Starting TNVT220) and establish a 
session with a remote host.

Before you can establish another session with a remote host, you 
must suspend the current session and return to TNVT220 
command mode. To do this, press Alt-T. When the TNVT220 
prompt is redisplayed, enter a command in the following format:

TNVT220> OPEN remote_host

TNVT220 prompts you to log in and then establishes a session to 
remotejiost.

For each additional session you want to establish, you must first 
return to command mode and then execute the OPEN command.

Although only one session can be active (current) at a time, you 
can switch between sessions.

When you are in terminal mode for a particular session, you can 
switch from one session to another, by pressing Alt-N 
(NextScreen).

When you are in command mode, you can switch the current 
session and either resume an established session or remain in 
command mode. You can also display information about all 
established sessions.

To switch sessions and resume an established session, enter a 
command in the following format:

TNVT220> RESUME [ session_number | remotejiost]

If you specify session_number or remotejiost, the session associated 
with the specified number or name becomes the current session and 
you resume that session. If you omit the options, this command 
resumes the previous current session.
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To switch the current session but remain in command mode, 
enter a command in the following format:

TN VT220> SELECT { session_number | rwnote_host}

To display information about all established sessions, enter the 
following command:

TNVT220> SESSIONS

The system responds with a display similar to the following:

Available session(s):
Session Id Destination

Internet Address Host Name

* 1 80.24.1.132 Chicago
2 80.14.1.13 atlanta

The asterisk (*) indicates the current session.

Printing a Copy of the Terminal Screen

If a printer is connected to your workstation while you are using 
TNVT220, you can print what an application (running on a remote 
host) displays on your screen.

To print, follow these steps:

1. Make sure the printer is set up properly and attached to 
your workstation.

2. Establish a TNVT220 session to a remote host.

3. Press Alt-S to enter TNVT220 setup mode.

TNVT220 displays the Setup Directory screen.

4. Select the printer option by highlighting it using the arrow 
keys.

5. Press either the grey + or the Enter key from the numeric 
keypad to display the Printer Setup screen.
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6. Define the following printer characteristics by highlighting 
each field using the arrow keys. Then press either the 
grey + or the Enter key from the numeric keypad, until the 
desired characteristic is displayed:

a. Specify the port (either parallel or serial) to which the 
printer is attached. The default printer port is PRN:.

b. Set the number of characters the printer can print on 
one line. You can set this for parallel ports only. The 
default value is 80 characters per line.

c. Set the printer operating mode to normal, auto, or 
controller. The default mode is normal.

d. Set the number of lines printed per inch. You can set 
this for parallel ports only.

For information about printer characteristics, refer to the 
section Printer Setup Screen in the LAN Workplace for DOS 
Administrator’s Guide.

7. Press Alt-P to print a screen.

1111^ When your workstation is not emulating a terminal, 
normally you press Shift-PrtSc to print a screen. 
However, when your workstation is emulating a 
terminal, you must use Alt-P because the 
computer's ROM BIOS (which handles the printing) 
is not synchronized with the TNVT220 software.
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Running a DOS Program While In TNVT220

You can suspend a TNVT220 session, return to the DOS prompt, 
and run a DOS program using one of the following methods:

• When you are in TNVT220 command mode, enter the ! 
(exclamation point) command and press the Enter key:

TNVT220> !

• When you are in any other mode (except setup mode), 
press Alt-D.

1111^ You cannot suspend a TNVT220 session and return 
to the DOS prompt when TNVT220 is in setup 
mode.

When you suspend a TNVT220 session, TNVT220 returns you to 
the DOS prompt. You are on the drive and in the directory you 
were in before you started or last suspended TNVT220.

To return to the TNVT220 session that you suspended, enter the 
following command and press the Enter key:

C> EXIT

1111^ If you execute the DOS SET command while a TNVT220 
session is suspended, any characteristics you set affect only 
that DOS session. When you quit TNVT220 and return to the 
DOS prompt, all SET characteristics are restored to the values 
they had before you started TNVT220.
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Closing or Quitting a TNVT220 Session

When you finish a TNVT220 session with a remote host, you can 
close the session with the remote host and either remain in 
TNVT220, or quit TNVT220 and return to the DOS prompt.

One way you can close a session is to log out from the remote 
host. If you have only one session open when you log out, 
TNVT220 quits and returns you to the DOS prompt. If you have 
more than one session open when you log out, 1NVT220 returns 
you to the TNVT220 prompt.

You can also close a specific session and remain in TNVT220 by 
entering a command in the following format:

TNVT220> CLOSE [ session_number | session_host ]

If you specify the session ID, session_numb er, or the name of the 
remote host, sessionjiost, TNVT220 closes the specified session. If 
you omit the options, TNVT220 closes the current session.

To close all sessions, exit from TNVT220, and return to the DOS 
prompt, enter the following command:

TNVT220> QUIT

Unloading TELAPI

TNVT220 displays the following prompt:

One or more sessions currently exist. Do you want to exit ( Y | N ): Y

If you enter Y, TNVT220 quits and returns you to the DOS 
prompt. You are on the drive and in the directory you were in 
prior to starting TNVT220. Any characteristics that you redefined 
with the DOS SET command are restored to the values they had 
prior to starting TNVT220.

After you exit from TNVT220, you can unload TelAPI to free the 
allocated data space. To do so, enter the following command at 
the DOS prompt:

C> TELAPI -u
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Connecting to a Different National Language Host

TNVT220 lets you connect your workstation to the following 
national language hosts:

• British

• Danish

• Dutch

• Finnish

• Belgian

• French

• French Canadian

• German

• Italian

• North American

• Norwegian

• Spanish

• Swedish

• Swiss (French)

• Swiss (German)

• Multinational

To emulate any of the above terminals, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.
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3. Select the terminal type field using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad, until the desired terminal type is 
displayed.

If you want TNVT220 to open sessions automatically with 
this terminal type, continue with Step 4. Otherwise, skip to 
Step 5.

4. Select the Save option using the keyboard's arrow keys. 
Then press the grey + or the Enter key on the numeric 
keypad to save the setting.

5. Press Alt-S to exit from the Setup Directory screen and 
return to the TNVT220 session.

When you select a particular terminal type, such as German, you 
can send and receive German symbols and characters from the 
host. If you press a key that is not available in the German 
character set, the keyboard beeps.

For information about national language hosts, refer to the LAN 
Workplace for DOS Administrator's Guide.

Redefining the Back Arrow Key

When you press the Backspace key (the <- Backspace key) on the 
main keyboard, it deletes the character immediately proceeding 
the cursor. Depending on the system, pressing the Backspace key 
generates either a backspace character or a delete character. Some 
hosts expect the Backspace key to generate a backspace character. 
Other hosts expect the Backspace key to generate a delete 
character. The character to the left of the cursor is deleted only if 
the host receives the character it expects.

By default, TNVT220 generates a backspace character when you 
press the Backspace key. However, when you open a session with 
a host that expects a delete character (such as a host running the 
VMS operating system), you must change the default setting of 
the Backspace key and set it to Delete.
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To change the default setting of the Backspace key, follow these 
steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Keyboard field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the Keyboard Setup screen.

5. Select the field Backspace=BS, using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad, to toggle the field to Backspace=Del.

If you want TNVT220 to open sessions automatically with 
the selected back arrow setting, continue with Step 6. 
Otherwise, skip to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit from the Setup Directory screen and 
return to the TNVT220 session.

Other TNVT220 Features

Once you establish a TNVT220 session, TNVT220 lets you set the 
following features:

• Screen color

• Hardware versus ROM-BIOS screen access

• VT200 mode versus VT100 mode

This section describes how to set these features.
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Screen Color
If you have a color monitor, once you have established a TNVT220 
session you can define the foreground and background color of 
your screen. You can also define the color of the bold and 
underlined characters on the screen. If you established multiple 
TNVT220 sessions, you can specify a different set of colors for each 
session; however, you can save only one set as the default colors. 
The following colors are supported for color monitors: green, white, 
black, blue, cyan, red, magenta, and brown.

To change the colors of your screen display, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Display field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the Display Setup screen.

5. Select the color field you want to change, using the 
keyboard's arrow keys. Then press the grey + or the Enter 
key on the numeric keypad, until the desired color is 
displayed.

If you want 1NVT220 to open a session automatically with 
the selected colors, continue with Step 6. Otherwise, skip 
to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit the Setup Directory screen and return to 
the TNVT220 session.

For further information about screen colors, refer to the 
description of the Display Setup screen in the LAN Workplace for 
DOS Administrator's Guide.
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Direct Hardware Versus ROM-BIOS Screen Access
TNVT220 lets you determine the screen-access mode when 
emulating a VT52, VT100, or VT220 terminal. The TNVT220 
software can access the screen in either of the following modes:

• Direct hardware - In direct-hardware mode, you access 
the screen via the workstation's video adapter board. 
Because of this, your video adapter board must be 100% 
compatible with a standard display adapter (such as an 
MDA, a CGA, a Hercules-compatible adapter, an EGA, or 
a VGA board). Use this method when running TNVT220 
under Windows 3.0 Enhanced mode or under DESQView.

• ROM-BIOS - In ROM-BIOS mode, you access the screen 
via the workstation's ROM BIOS. ROM-BIOS mode works 
with all PC compatibles, even if they have incompatible 
display adapters. You must use this method when running 
TNVT220 under Windows 3.0 Standard or Real mode.

1111^ Running TNVT220 in direct-hardware mode gives 
the best performance. Use ROM-BIOS access mode 
only if you have compatibility problems or 
environmental restraints.

The default screen-access mode is the direct-hardware mode. To 
change to ROM-BIOS mode, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Display field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad 
to display the Display Setup screen.

5. Select the HardwareAccess field, using the keyboard's 
arrow keys. Then press the grey + or the Enter key on the 
numeric keypad to toggle the field to ROM-BIOS Access.

If you want TNVT220 to open a session automatically with 
the selected mode, continue with Step 6. Otherwise, skip 
to Step 7.
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6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit the Setup Directory screen and return to 
the TNVT220 session.

VT200 Mode Versus VT100 Mode
The VT200 mode executes standard ANSI functions and lets you 
use the full range of VT220 capabilities. For application programs 
that expect 7-bit control characters, and either ASCII characters 
or national replacement characters, you must use the VT200 
mode, 7-bit setting. Most VT100 application programs will run in 
this setting. For application programs that send and receive 8-bit 
control characters and DEC multinational characters, you must 
use the VT200 mode, 8-bit setting.

The VT100 mode executes standard ANSI functions. You must 
use this mode with application programs that require strict 
compatibility with Digital's VT100 terminal.

To change the mode, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the General field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the General Setup screen.

5. Select the VT200 mode, 7-bit field, using the keyboard's 
arrow keys. Then press the grey + or the Enter key on the 
numeric keypad, until the desired mode is displayed.

If you want TNVT220 to open a session automatically with 
the selected mode, continue with Step 6. Otherwise, skip 
to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
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keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit and return to the TNVT220 session.

Using Third-Party Terminal Emulators

The Telnet Session Utility (TSU) lets third-party, LAN-compatible 
data communication applications use TelAPI. When using 
TelAPI, the third-party application can communicate with remote 
hosts that are running the Telnet client program.

TSU uses TelAPI to open and close Telnet sessions with remote 
hosts. TSU also lets you configure the Telnet session used by the 
application. You.can configure the Telnet session by specifying 
command-line options when you start TSU. After you have 
started TSU, you can configure the Telnet session by selecting 
options from the TSU menus.

Using TSU, you associate a DOS serial port with a Telnet session 
to a remote host. The DOS serial port used is the one to which the 
third-party application would normally direct its data. TSU 
redirects the data from third-party application to the remote host 
via the associated DOS serial port.

You can call TSU from a batch file. Figure 6-2 shows a sample 
batch file that opens one Telnet session and then starts a 
third-party terminal emulator.

Starting TSU

To start a session with a remote host and then run a third-party 
terminal emulator, follow these steps:

1. Load TelAPI:

C> TELAPI -SN sessions

sessions can be a value from 0 to 10. The default value is 2.
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Figure 6-2
TSU Batch File echo off

rem Open a session to the host kansas with hostid k1 
tsu —o kansas kl
if errorlevel 1 goto open_error
rem Attach hostid k1 to COM3
tsu -a k1 COM3
if errorlevel 1 goto attach_error
rem Start third-party terminal emulator 
program_name
rem Close the session
tsu —c k1
if errorlevel 1 goto close_error 
goto exit
rem
:open_error
echo Open session failed
goto exit
:attach_error
echo Attach session failed
goto exit
:close_error
echo Close session failed
:exit
tsu —c k1

1111^ Each session requires about 1700 bytes. When using 
TelAPI with third-party terminal emulators, you 
must allocate space for at least one session.

2. Start TSU:

C> TSU

TSU displays the main menu (see Figure 6-3). This menu is 
divided into two areas, the Sessions List and the Session 
Utility Commands. The Sessions List displays all the 
currently open sessions. The Session Utility Commands 
displays the function keys you use to open, close, and 
configure sessions. When a function key is highlighted, a 
short description of it is displayed at the bottom of the 
Session Utility Commands.
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Figure 6-3
TSU Main Menu

-------------------------------- Sessions List
No. Host Name Id Port

1 sales 89.32.8.83 COM1

Connection established successfully

1 Help 31Open
I------------------- Session Utility Commands

4 Close 5 Config 6 Attach 7 Reset 8 Unload 9 Update 10 Exit

Open a Telnet session

3. Press function key F3 (Open) to open a session with a 
remote host.

The system prompts you for the name of the remote host.

4. Enter the name of the remote host and press the Enter key.

The system prompts you for a session ID.

5. Press the Enter key to accept the default value, or enter a 
session ID and press the Enter key.

The system prompts you for the port number.

6. Press the Enter key to accept the default port number, or 
enter a port number and press the Enter key.
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llll^ Specify a remote port number only if you know that 
the Telnet server on the remote host is not using the 
default Telnet TCP port.

1111^ The third-party emulator must be configured to 
access the port associated with the TSU session.

TSU opens the session with the remote host and attaches the 
session to a port. (TSU automatically attaches the first session 
to port C0M1, the second to COM2, and so on.)

7. Press function key F10 (Exit) to exit from TSU.

8. Enter the name of the emulator program at the DOS 
prompt, to run your third-party terminal emulator.

Following Step 8, you have started a Telnet session with a 
third-party terminal emulator.

Ending a Session with a Third-Party Terminal Emulator

To end a session with a third-party terminal emulator, log out 
from the remote host at the terminal emulator prompt. When you 
do this, TelAPI automatically closes the TSU session. However, if 
the session does not close, you must start TSU by entering the 
following command at the DOS prompt:

C> TSU

When TSU displays the main menu, press F4 (Close) to close the 
session. The system prompts you for confirmation. Enter Y to 
close the session. After you close the session, you can use TSU to 
unload TelAPI by pressing F8.

1111^ If you unload TelAPI, you must exit TSU before you can 
reload TelAPI.
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7
TRANSFERRING FILES

The LAN Workplace software provides three command-line 
utilities that let you transfer files between your workstation and a 
remote host.

• File Transfer Program (FTP) - Lets you access files and 
directories on the local or remote host, transfer single or 
multiple files, and perform common directory and file 
operations. FTP performs user authentication on the 
remote host based on passwords.

• Trivial File Transfer Program (TFTP) - Lets you transfer 
single files. TFTP performs no user authentication.

• Remote Copy Program (RCP) - Lets you transfer single or 
multiple files. RCP performs user authentication based on 
entries in the HOSTS.EQUIV and .RHOSTS files. Refer to 
the LAN Workplace for DOS Administrator's Guide for a 
discussion of these files.

Using the File Transfer Program (FTP)

The FTP utility lets you transfer files between your workstation 
and a remote host on the local or remote network. FTP also lets 
you access local and remote directories and files and perform 
common directory and file operations. These operations include 
listing and changing working directories, listing directory 
contents, and renaming directories and files.

IIII^ Before you can use FTP, the remote host must be running 
an FT P server program.

Using the File Transfer Program (FTP) 7-1



LAN Workplace for DOS User's Guide

Starting FTP

You can start FTP and log in to a remote host, if the following 
conditions are true:

• The remote host recognizes you as a valid user.

• You can provide a password, if one is required by the 
remote host.

• An entry for the remote host is present in the host name 
database. The database is either a Domain Name System 
(DNS) name server (if one exists on your network) or the 
file \XLN\TCP\HOSTS on your workstation.

To start FTP and log in to a remote host, enter a command in the 
following format at the DOS prompt:

C> FTP [ remote_host]

If you specify remote_host, FTP prompts you to log in and then 
connects you to that host. If you omit remotejiost, FTP prompts 
you for the name of the remote host.

Assume that the user Evelyn wants to log in to the remote host 
sales. To do this, she can start FTP and log in to sales using either 
of the following methods.

Method 1:

C> FTP
ftp> OPEN sales
Connected to sales
220 sales FTP Server (<version> <date>) ready.
Remote user name: evelyn
Password: password
ftp>

Method 2:

C> HP sales
Connected to sales.
220 sales FTP Server (<version> <date>) ready.
Remote user name: evelyn
Password: password
ftp>
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Getting File and Directory Information

After you start FTP, you can use FTP commands for operations 
such as getting file and directory information, listing directory 
contents, and changing working directories.

The FTP HELP command lists all available FTP commands:

ftp> HELP

llll^ There are more FTP commands available when a session is 
open (active) than when no sessions are open.

When you first open a connection to a remote host, you are in 
your home directory on that host. You can find the full pathname 
of this directory with the following command:

ftp> PWD

Information similar to the following is displayed.

7x/sales/evelyn" is current directory.

You can list the contents of the current working directory on the 
remote host with either of the following commands:

ftp> DIR
ftp> LS

If the remote host is a UNIX system, the DIR command gives a 
detailed list of the directory's contents similar to the following:

-rw-r-r- 1 evelyn 425 Oct 22 16:56 calendar
drwxr-xr- 2 evelyn 512 Sep 15 16:36 general
drwxr-xr- 2 evelyn 1536 Oct 26 12:44 status
drwxr-xr- 2 evelyn 512 Jul 210:19 updates

The LS listing for the same directory would look like this:

calendar
general 
status 
updates
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You can change the working directory on the remote host by 
entering a command in the following format:

ftp> CD remote_directory

llll^ You must specify the name of the remote directory in a 
form that the remote host understands. For example, if the 
remote host is a UNIX system, separate directory names 
with slashes (/); if the remote host is a VMS system, 
separate the directory names with periods (.) and enclose 
them in square brackets ([ ]).

You can perform the same operations for files and directories on 
your workstation using the LPWD, LDIR, LLS, and LCD 
commands. The letter "L" preceding the command name 
indicates that the command is performed locally. To execute these 
commands you do not need to be connected to a remote host. 
The following sequence of commands illustrates the responses to 
these FTP commands:

C> FTP
ftp> LPWD

“cA" is current directory.
ftp> LCD MKTG
ftp> LLS
memos
bulletin.txt
reportl .doc
report2.doc
mktg.gem

ftp> LDIR
memos <DIR> 4-23-87 12:01
bulletin.txt 6978 10-06-87 12:30 RA
reportl .doc 15927 10-29-87 12:45 A
report2.doc 21734 10-30-87 1:03
mktg.gem 8133 10-29-87 1:25 A
5 File(s)
ftp>

The LDIR command lists the file or directory name, the length of 
the file (or <DIR> to indicate a directory), the date and time the 
file or directory was last modified. It may list whether the file has 
been modified since the last backup archive (A) and whether the 
file is read-only (R). These are DOS file attributes.
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Copying Files

The FTP commands lets you copy files between your workstation 
and the remote host, or between two remote hosts.

1111^ If the remote host has a case-sensitive file system, such as 
UNIX, all remote file names must be entered in the proper 
case. This is necessary for all FTP commands.

Copying Files to a Remote Host
You can use the following FTP commands to copy one or more 
files from your workstation to a remote host:

• PUT - Copy one file to a remote host

• MPUT - Copy one or more files to a remote host

• COPY - Copy one or more files or directories, or a 
directory tree to a remote host

The following examples show you how to use the commands 
PUT and MPUT. The COPY command is discussed in the section, 
Copying Files Between Remote Hosts.

To copy the file REPORT1.DOC from your workstation to the 
current directory on the remote host and retain the name 
REPORT1.DOC:

ftp> PUT REPORT1.DOC

To copy the file REPORT1.DOC from your workstation to the 
directory reports on the remote UNIX system and rename the file 
reportl.txt:

ftp> PUT REPORT1.DOC reportsZreport1.txt

To copy all files with the extension .DOC from your workstation 
to the current directory on the remote host:

ftp> MPUT *.DOC
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Copying Files to Your Workstation
You can use the following FTP commands to copy one or more 
files from a remote host to your workstation:

• GET - Copy one file to your workstation

• MGET - Copy one or more files to your workstation

• COPY - Copy one or more files or directories, or a 
directory tree from a remote host

The following examples show you how to use the GET and 
MGET commands. The COPY command is discussed in the 
following section, Copying Files Between Remote Hosts.

To copy the file reportl.txt from the current directory on the 
remote UNIX system and retain the name reportl.txt:

ftp> GET reportl.txt

To copy the file reportl.txt from the current directory on the 
remote UNIX system to the directory REPORTS on your 
workstation and rename it REPORT1.DOC:

ftp> GET reportl.txt REPORTS\REPORT1.DOC

To copy all files that start with the name report (and that conform 
to the local naming conventions) from the current directory on 
the remote UNIX system to the current directory on your 
workstation:

ftp> MGET report*

Copying Files Between Remote Hosts
The FTP COPY command lets you copy files between two remote 
hosts as well as between your workstation and a remote host. It 
also lets you copy an entire directory and all its subtrees.

Illl^ When you use the COPY command, FTP automatically 
opens connections to the remote hosts (if they are not yet 
open), copies the specified files, and then closes the 
connections when it is finished copying the files.
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To copy a single file to a file or a directory, enter a command in 
the following format:

COPY source_file [destination_file\ destinafon_directory]

source_file is the name of a file (on your workstation or on the 
remote host) that you want to copy to either the file, 
destinationJile, or the directory, destination_directory, on your 
workstation or on the remote host.

To copy multiple files to a directory, enter a command in the 
following format:

COPY source_file [ source_file... ] destination_directory

source_file is the name of a file (on your workstation or on the 
remote host) that you want to copy to the directory, 
destination_directory, on your workstation or on the remote host.

To copy a directory to a directory, enter a command in the 
following format:

COPY [-R] source_directory [source_directory... ] 
destination_directory

The -R option lets you copy directories recursively. You must 
specify this option if source_directory contains one or more 
directories. source_directory is the name of a directory (on your 
workstation or on the remote host) that you want to copy to the 
directory, destination_directory, on your workstation or on the 
remote host.

1111^ If you use the -R option, you cannot specify names with 
wildcard characters in source_directory.

1111^ The last file or directory on the command line is the 
destination.

1111^ The COPY command assumes the files and directories are 
on your workstation unless you precede the file or 
directory name with the remote host name and an equal 
sign (=).

The following sections illustrate how to use the COPY command.
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Copying Directories
Assume you want to copy the contents of a remote directory 
(DUAO:[MARCH]) from a VMS system (VENUS) to the directory 
REPORTS on your workstation, enter the following command:

ftp> COPY VENUS=DUAO:[MARCH] REPORTS

To copy the contents of a directory (MARCHX REPORTS) on your 
workstation to a directory (DUAO:[MARCHD on the VMS system 
(VENUS), enter the following command:

ftp> COPY MARCHXREPORTS VENUS=DUAO:[MARCH]

To copy the contents of a directory (DUAO:[MARCH]) from a 
VMS system (VENUS) to directory (reports) on a UNIX system 
(soles), enter the following command:

ftp> COPY VENUS=DUAO:[MARCH] sales=reports

Copying Directory Trees
The -R option of the COPY command lets you copy an entire 
directory tree recursively. When you specify the -R option, the 
destination must be a directory.

To illustrate how the -R option works, assume the following 
directories are present in the current directories of your 
workstation and the remote UNIX host soles:

Your workstation Remote Host sales

ACCOUNTS 
I

MARCH

CITY COUNTY

SALES.DOC SALES.DOC

field 

customers

To copy all the directories in ACCOUNTSXMARCH and place 
them under field/customers, enter the following:

ftp> COPY -R ACCOUNTS\MARCH sales=field/customers
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The resultant directories look like this:

Your workstation Remote Host sales

ACCOUNTS 
I 

MARCH

CITY COUNTY
I I

SALES.DOC SALES.DOC

field
I

customers

city county

sales.doc sales.doc

Notice that the directory MARCH is not created on sales.

Using Wildcard Characters
You can use the following wildcard characters with all HP 
commands that have a file or directory name as a parameter:

• Asterisk (*) - Represent any number of characters in that 
position.

• Question mark (?) - Represent any single character in that 
position.

The wildcard characters are interpreted on the remote host 
according to the remote host's conventions.

1111^ You cannot use wildcard characters with the -R option of 
the COPY command.

The following examples illustrate how to use the wildcard 
characters.

If the remote host is a DOS system, the following command lists 
all files in the current remote directory that have the file name 
ABC. If the remote host is a UNIX or VMS system, this command 
lists all files whose names begin with the four characters "ABC.":

ftp> LS ABC.*
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If the remote host is a DOS system, the following command 
copies all files (with the extension OC preceded by any other 
single character) from the current directory on the remote host 
and places them in the current directory on your workstation (in 
files of the same name). If the remote host is a UNIX or VMS 
system, this command copies all files with names ending in the 
four-character extension ".?OC"; the ? character can be replaced 
by any other single character:

ftp> MGET*.?OC

Transferring Text and Nontext Files

By default, FTP transfers files in ASCII transfer mode. In this 
mode, FTP assumes all files being transferred are text files (even 
if they are not). If you are transferring nontext files, such as 
executable files, you must change the transfer mode to binary so 
that the files are transferred properly. In binary mode, FTP 
assumes all files being transferred are binary files (even if they 
are not).

To change the transfer mode to binary, enter the following 
command:

ftp> BINARY

To return to ASCII transfer mode, enter the following command:

ftp> ASCII

To determine the current transfer mode, enter the following 
command:

ftp>STATUS

You can also let FTP determine whether the file it is copying to 
you workstation is an ASCII or binary file (and transfer it 
accordingly) by executing the FORCE command. When you 
start FTP, FORCE is on. When it is on, FTP transfers files 
according to current transfer parameter setting, either ASCII or 
binary mode.
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FORCE is a toggle command. Therefore, when you enter the 
following command, you turn FORCE off:

ftp> FORCE

When it is off, FTP uses the files attributes of each file it is 
transferring (to your workstation) to determine the transfer 
parameters. If a file is text, it is transferred in ASCII mode. If a file 
is binary, it is transferred in binary mode.

Use the FTP STATUS command to determine whether FORCE is 
on or off. When it is on, STATUS displays the following message:

Transfer files according to current transfer parameter settings.

When FORCE is off, the above message is not displayed.

Running a DOS Program While in FTP

You can suspend the FTP utility and run a DOS program at any 
time by entering either of the following commands:

ftp> !
ftp> LEXEC

After you enter either of these commands, the DOS prompt is 
redisplayed. You are on the drive and in the directory that you 
were in prior to starting the FTP session and you can perform 
DOS operations.

While FTP is suspended, all connections that you have opened 
during the Fir session remain open (unless the remote host 
terminates the connection).

To return to FTP, type the word EXIT at the DOS prompt and 
press the Enter key. FTP redisplays the "ftp>" prompt indicating 
you are in EPP command mode.

1111^ If you execute the DOS SET command while FTP is 
suspended, any characteristics you set affect only that 
DOS session. When you exit from Fi r and return to the 
DOS prompt, all SET characteristics are restored to their 
previous values.
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Closing FTP Sessions

When you finish an FTP session with a remote host, you can 
either close the current session with the remote host and remain 
in FTP or close all sessions, exit from FTP, and return to the DOS 
prompt.

To close the current connection and remain in FTP, enter the 
following command:

ftp> CLOSE

To close all the connections, exit from FTP, and return to the DOS 
prompt, enter either of the following commands:

ftp> QUIT
ftp> BYE

When you exit from FTP and return to the DOS prompt, you are 
on the drive and in the directory that you were in when you 
started FTP. Also, all characteristics defined with the DOS SET 
command are restored to their previous values.

Entering FTP Commands from a Script File

Fl P lets you enter commands interactively from the keyboard or 
from a script file. If you use a script file, autologin is disabled and 
you must log in with the FTP USER command. If the login 
requires a password and the command file does not provide one 
or the one provided is invalid, the remaining commands in the 
file are not executed. The following is an example of a script file. 
The italicized comments explain each line.

OPEN sales Open a connection to host sales
USER evelyn kumquat User name and password
LCD \XLN\TCP Change directories on your workstation
GET HOSTS HOSTS.NEW An FTP command
CLOSE Terminate the FTP connection
BYE Conclude the FTP session
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To execute this command file, enter either of the following:

C> FTP < GETHOSTS
C> FTP -X < GETHOSTS

llll^ If you open an FTP session from a command file the 
command file will not abort if an error is detected while an 
FTP command is executing. You must specify the -X 
option on the FTP command line to let FTP exit if any 
command fails.

Using Other FTP Commands

This section provides a brief description of other FT P commands. 
For further information about PTP commands, refer to the LAN 
Workplace for DOS Administrator's Guide.

APPEND

Append a local file to a remote file.

BELL Sound a bell after completing each file transfer command. 
This is a toggle command.

DEBUG

Toggle debugging mode. The default setting is off.

DELETE

Delete a single file on the remote host.

EXEC Execute the specified command on the remote host.

FILE Set the file transfer structure to FILE, which is an 
unstructured byte stream.

FORMAT

Display the current file transfer format. The default format 
is NONPRINT.
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HASH

Toggle printing a number sign (#) for each data block 
(1024 bytes) transferred. The default setting is off.

MDELETE

Delete one or more files from the remote host.

MDIR

List detailed contents of multiple directories on a remote host

MKDIR

Create a directory on the remote host.

MLS List brief contents of multiple directories on a remote host.

MODE

Display the current file transfer mode. The default mode is 
STREAM.

OPEN

Open a connection to the Fir server on the remote host if 
no connection exists.

PROMPT

Toggle interactive prompting for multiple commands. The 
default setting is off.

QUOTE

Send an Fir command to an FTP server, bypassing normal 
command parsing.

1111^ If you use this command improperly, the FTP 
session may be dropped or the Fir server may fail.
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RECV

Copy a file from the remote host to a file of the same name 
on the local host. This is equivalent to the GET command.

RECORD

Set the file transfer structure to RECORD; files are viewed 
as being partitioned into records.

REMOTEDIR

Enable or disable transferring remote directories with the 
GET and PUT commands. If you omit REMOTEDIR, Hr 
verifies whether the transferred object is a local file or 
directory. If you specify REMOTEDIR, FTP turns off this 
verification process and HF assumes that the transferred 
object is a file. This command is useful only to users 
accessing MVS servers that use the CWD and PWD 
protocol elements.

REMOTEHELP

Display help information from the remote H F server.

RENAME

Rename files on the remote host.

RGET

Copy a file from the remote host to a file of the same name 
on your workstation. The file is copied with the file 
transfer structure RECORD.

RMDIR

Delete a directory from the remote host.

RPUT

Copy a file from your workstation to a file of the same 
name on the remote host. The file is copied with the file 
transfer structure RECORD.
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SEND

Copy a file from your workstation to the current working 
directory on the remote host under the file's original name.

SENDPORT

Toggle the use of port commands. The default setting is on.

STATISTICS

Toggle the display of transfer statistics after each file 
transfer. By default, transfer statistics are displayed.

STRUCTURE

Display the current file transfer structure. The default file 
transfer structure is FILE.

TYPE

Display or set the current file transfer type. The default file 
transfer type is ASCII.

USER

Log in to the remote FTP server and identify user to 
remote host.

VERBOSE

Toggle verbose mode. The default setting is off.

? List all FTP commands.

Making Your Workstation an FTP File Server

You can make your workstation an FTP file server by running the 
FTPD utility. FTPD is an FTP server program. When your 
workstation is running FTPD, any network computer with an 
FTP client program can access your workstation to transfer and 
archive files.
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If you run FTPD from DOS, your workstation becomes a dedicated 
file server. If you run it under Windows 3.0 Enhanced mode or 
DESQview, your workstation does not become a dedicated file 
server; therefore, you can run other applications simultaneously. 
However, you can run only one FTPD window and you cannot use 
FTP to copy files from your workstation to itself.

To open an FTPD session enter either of the following commands 
on your workstation:

C> FTPD
C> FTPSERV

You can interrupt and terminate FTPD by entering either 
Ctrl-Break or Ctrl-C if either of the following are true:

• You entered the BREAK ON command at the DOS prompt 
before starting FTPD.

• The entry "BREAK=ON" is present in your CONFIG .SYS 
file.

After the FTP utility has transferred one or more files and exited, 
FTPD automatically terminates.

The LAN Workplace for DOS software creates the batch file 
FTPSERV during installation. You can use FTPSERV to open 
successive FTP sessions to your workstation. FTPSERV restarts 
FTPD after each FTP connection is closed, thus allowing the 
FTPD process to run continuously.

Illl^ Even if you are using FTPSERV, only one FTP session can 
be active at a time.

1111^ If you use any FTP program to connect to a workstation 
running FTPD, you cannot use the FTP EXEC command. If 
you do, FTP returns the error "Operation not supported."

To interrupt and terminate FTPSERV, enter Ctrl-Break or Ctrl-C.

FTPD User-Authorization File
If you are running FTPD, any network user can access files on 
your workstation unless you create the FTPD user-authorization 
file \XLN\HSTACC\FTPDUSR.LOG. When a network user tries 
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to open an FTP session on your workstation, FTPD checks 
FTPDUSR.LOG. Only the users listed in this file are authorized to 
access FTPD on your workstation.

You can create the FTPDUSER.LOG file using any ASCII editor. 
Each entry in the FTPDUSR.LOG file consists of one line in the 
following format

user_name [:passnmf]

user_name is the name of the user, password is an optional 
password for that user. user_name and password are not case 
sensitive. Neither can contain spaces or tab characters and they 
must be separated by a colon.

Each line of comments included the FTPDUSR.LOG file must be 
preceded by a number sign (#). The text following the number 
sign is interpreted as a comment.

FTPD Log File
You can record all FTP transactions serviced by FTPD, including 
the users requesting the service, the times they logged in and out, 
and the FTP commands they executed.

To create a log file, start FTPD with the -L and the -V options:

FTPD -LV [filename]

file_name is the name of the log file. If it does not exist, FTP 
creates it in the directory \XLN\HSTACC. If it exists, the new 
FTPD transaction information is appended to the file. If you omit 
the file name, FTPD sends log file information to STDERR 
(usually the screen). You cannot specify a path with file_name.

Using the Trivial File Transfer Program (TFTP)

The TFTP utility lets you transfer files between your workstation 
and a remote host that is running the TFTP server program. TFT P 
does not require a password.
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Transferring Files

The TFTP utility lets you transfer files between your workstation 
and a remote host.

111!^ Before you can transfer a file to a remote host, a file of the 
same name must exist on the remote host and it must have 
world ("other") write permission or TFTP will fail.

Copying Files to a Remote Host
To copy a file from your workstation to a remote host, enter a 
TFTP command in the following format:

TFTP sourcejile remote_host-destinationjil&

sourcejile is the name of the file you are copying. If it is not in the 
current directory, you must specify it as a partial or complete 
pathname.

remotejiost is the name of the destination host. It must be 
followed immediately by an equal sign (=).

destinationJile is the name given the file when it is copied. If you 
specify a name, it must be an absolute path name. If you omit the 
name, the file is copied to the current directory on remotejiost 
under the same name.

The following examples show you how to copy files to a remote 
UNIX system (sales) using IM P.

To copy the file MARCH\ACCOUNTS.TXT from your 
workstation to the directory fxlmarchlon the remote host sales, 
enter the following command:

C> TFTP MARCH\ACCOUNTS.TXT sales =/x/march/accounts.txt
The destination directory (fxlmarch) must exist on the remote host 
and the destination file (accounts.txt) must exist in Ixlmarch and 
have world ("other") write permission.
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Copying Files from a Remote Host
To copy a file from a remote host to your workstation, enter a 
TFIF command in the following format:

C> TFTP remo(e_host-source_file destinationjile

source_füe is the name of the file you are copying. It must be an 
absolute pathname.

destination_file is the name given the file when it is copied. If it is 
not in the current directory, you must specify it as a complete 
pathname. If you omit destination-file, TFTP copies it to the 
current directory on your workstation under the same name.

The following examples illustrate how to copy files from a 
remote host using TFTP.

To copy the file /february/accounts from the remote UNIX system 
sales to the current directory on your workstation, enter the 
following command:

C> TFTP sales=/february/accounts.txt

To redirect the contents of the file Ifebruarylaccounts to your 
screen, enter either of the following commands:

C>TFTP sales=/february/accounts.txt -
or

C> TFTP sales=/february/accounts.txt - | MORE

Making Your Workstation a TFTP File Server

You can make your workstation a TFTP file server by running the 
TFTP server program, TFTPD. When your workstation is 
running TFTPD, any network computer with a TFTP client 
program can access your workstation and transfer files. If you 
dedicate your workstation as a file server, network users can 
archive files on it.

If you run TFTPD from DOS, your workstation becomes a 
dedicated file server. If you run it under Windows 3.0 Enhanced 
mode or DESQview, your workstation does not become a dedicated 
file server; therefore, you can run other applications simultaneously. 
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However, you can run only one TFTPD window and you cannot 
use TFTP to copy files from your workstation to itself.

To make your workstation a TFTPD server, enter the following 
command:

C> TFTPD

You can record all TFTP transactions serviced by TFTPD in a log 
file by entering a command in the following format:

TFTPD -L(log_file]

log_file must exist on your workstation before you can specify 
this option. The default log file is XSYSLOG.DAT.

To terminate TFTPD, press either Ctrl-Break or Ctrl-C.

Using Remote Copy Program (RCP)

The RCP utility lets you copy files and directories between your 
workstation and a remote host running the remote shell server, 
RSHD and a server RCP program.

For DOS-to-UNIX transfers, RCP converts all file and directory 
names to lowercase and removes the DOS drive specifiers before 
the names are sent to the remote host.

For UNIX-to-DOS transfers, RCP prompts for a new file name if 
the UNIX file or directory name is an invalid DOS file or 
directory name. If you specify the -I option when starting RCP, 
files with invalid DOS file or directory names are not copied.

Refer to the LAN Workplace for DOS Administrator's Guide for 
further information about file name specifications when copying 
files between various operating systems.
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Transferring Files

The RCP command lets you transfer files between your 
workstation and a remote host.

1111^ RCP determines the username from the DOS environment 
table. You must specify the username with the SET NAME 
command. The SET NAME command is appended to your 
AUTOEXEC.BAT file when you install the LAN 
Workplace software.

Copying Files to a Remote Host
To copy a file from your workstation to your account on a remote 
host, enter a command in the following format:

RCP source_file remote_host=destination_file

To copy a file to another user's account on a remote host, enter a 
command in the following format:

RCP source_file usei@remote_host=destination_file

To copy a directory recursively from your workstation to your 
account on a remote host, enter a command in the following format:

RCP -R source_dir&ctory r0mote_host=destination_dir&ctory

source_file is the name of the file you want to copy.

source_directory is the name of the directory you want to copy.

destination_file is the name given the file when it is copied to 
remotejiost.

destinationjdirectory is the name given the directory when it is 
copied to remote_host.

remote_host is the name of the destination host; it must be 
followed immediately by an equal sign (=).

user is the name of another user's account to which you have 
access permission.
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The following examples show you how to use the RCP utility to 
copy files from your workstation to a remote host.

To copy a file to your home directory on the remote UNIX system 
and rename the file:

RCP SALES.RPT financa=report.txt

To copy a file to the user EVELYN'S home directory on the 
remote UNIX system finance and rename the file:

RCP SALES.RPT evelyn@flnance=reporttxt

To copy a directory recursively from your workstation to a 
directory on the remote UNIX system:

RCP -R C:\REPORTS\*.* flnance=/x/evelyn/reports

Copying Files from a Remote Host
To copy a file from your account on a remote host to your 
workstation, enter a command in the following format:

RCP remote_host=source_file destinationjile

To copy a file from another user's account to your workstation, 
enter a command in the following format:

RCP usei@remote_host=source_file destinationjila

To copy one or more files from the remote host to a directory on 
your workstation, enter a command in the following format:

RCP -R remote_hosUsource_directory destination_directory

destination_file is the name of the destination file.

destination-directory is the name of the destination directory.

source_file is the name of the file to be copied.

sourcejiirectory is the name of the directory to be copied.

remotejiost is the name of the source host; it must be followed 
immediately by an equal sign (=).
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user is the name of another user's account to which you have 
access permission.

The following examples show you how to use the RCP utility to 
copy files from a remote host to your workstation.

To copy a file from a remote UNIX system to your workstation 
and rename the file:

RCP flnance=/x/evelyn/report1.txt \REPORTS\REPORT1.DOC
To copy all directories, subdirectories, and files from a directory 
on the remote UNIX system to your workstation:

RCP -R financa=/x/evelyn/reports/* \REPORTS

To copy all directories recursively from another user's home 
directory on a remote UNIX system to your workstation:

RCP -R carlyle@flnance=* \REPORTS

Backing up and Restoring Files

RCP lets you back up the files on your hard disk tQ a remote host, 
and restore them on your workstation. The following examples 
show how to use RCP to backup and restore files.

To back up all files and directories from the C: drive on your 
workstation to a directory on the remote UNIX system finance:

RCP -R -B C:\*.* finance=/x/evelyn/backup

To restore all back up files and directories from the remote UNIX 
system to the C: drive on your workstation:

RCP -R -B finance=/x/evelyn/backup/* C:\
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Terminating a File Transfer

You can terminate a file transfer before it has concluded by 
pressing Ctrl-C or Ctrl-Break, if either of the following is true:

• You entered the following command at the DOS prompt:

C> BREAK ON

• You included the following line in your CONFIG.SYS file:

After RCP aborts, you may need to delete partially copied target 
files on your workstation or the remote host.
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PRINTING ON A REMOTE PRINTER

The LAN Workplace software provides command-line utilities 
for printing DOS files on a printer connected to a remote host:

• RPR - lets you send a job to a remote printer.

• RPS - lets you check the status of a job in the remote 
printer's queue.

• RPD - lets you delete a job from the remote printer's 
queue.

Before you can print files on a remote printer, the printer 
configuration file \XLN\HSTACC\PRINT.CFG must exist 
on your workstation and an RSH server must be running 
on the remote host.

The printer configuration file defines the remote printers that you 
can access from your workstation. Refer to the LAN Workplace for 
DOS Administrator's Guide for information on setting up a printer 
configuration file.

Sending a File to a Remote Printer

The RPR utility lets you print a file on a printer connected to a 
remote host. To do this, enter a command in the following 
format:

C> RPR [-P remote_printer] file_name
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1111^ If you do not specify the -P option, RPR uses the first 
printer entry listed in the printer configuration file. The 
first entry is the name of the default printer.

remote_printer is the name of the remote printer you want to use.

filejume is the name of the file or files you want to print.

You can print more than one file at the same time. The following 
examples show two ways to do this:

C> RPR -P LASER1 JAN.SLS FEB.SLS MARCH.SLS
C> RPR -P LASER1 *.SLS

The files are grouped together and become one print job.

If the remote printer is on a VMS system, RPR displays a message 
similar to the following:

job 936 (queue 3, entry 1) queued

If the remote printer is on a UNIX system, RPR typically displays 
no message.

Checking the Status of a Print Job

The RPS utility lets you check the status of your print job. To find 
the status of a file that is queued for printing on a remote printer, 
enter a command in the following format:

C> RPS[-P remotejorinter]

llll^ If you do not specify the -P option, RPS checks the first 
printer entry listed in the printer configuration file. The 
first entry is the name of the default printer.

remote_printer is the name of the printer.
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The status message displayed depends on the remote host. If the 
remote printer is on a UNIX BSD system, RPS displays a status 
message similar to the following:

laserl is ready and printing
RankOwner Job Files Total Size
1st evelyn 936 march.sls 333 bytes
2nd carlyle 937 spin.c 100276 bytes

If the remote printer is on a VMS system, RPS displays a status 
message similar to the following:

Printer queue SYS$PRINT, running on SPRINTER, mounted on 
DEFAULT
Job name User name Entry Blocks Status
march.sls evelyn 161 1 pending
spin.c carlyle 162 10 pending

Deleting a Job from the Print Queue

The RPD utility lets you delete a print job from a queue on a 
remote printer.

1111^ Before you can delete a print job, you must find its job ID 
using the RPS command. If the remote printer is on a 
UNIX BSD system, RPS displays the job ID in the Job 
column. If it is on a VMS system, RPS displays the job ID 
in the Entry column.

To delete a file from a specified queue, enter a command in the 
following format

C> RPD[-P remote_printer]job_ID

llll^ If you omit the -P option, RPD uses the first printer entry 
listed in the printer configuration file. The first entry is the 
name of the default printer.

remote_printer is the name of the printer where the job is queued.

job_ID is the identification number of the job you want to delete.
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The response displayed when a print job is deleted depends on 
the remote host. If the remote printer is on a UNIX BSD system, 
RPS displays a message similar to the following:

evelyn_pc: dfA936sales dequeued

If the remote printer is on a VMS system, typically no message is 
displayed when a print job is deleted.
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USING YOUR WORKSTATION AS A TERMINAL

The LAN Workplace software provides the TNVT220 terminal 
emulation utility that runs under standard DOS. The TNVT220 
utility lets your workstation emulate a DEC VT220, VT100, or VT52 
terminal directly connected to a remote host.

A terminal emulator lets you log in to a remote host as if you are 
using a terminal directly connected to the remote host. After you 
log in, you can execute any commands and perform any 
operations that the remote host supports. The TNVT220 utility 
accesses the services of Telnet clients on other computers via the 
Telnet Application Program Interface (TelAPI).

The LAN Workplace software also provides the Telnet Session 
Utility (TSU) that lets you use network-compatible third-party 
terminal emulators via TelAPI.

1111^ To connect to a remote host with TNVT220 or TSU, the 
remote host must be running a Telnet server program.

Using the TNVT220 Terminal Emulator

The TNVT220 terminal emulation utility lets your workstation 
emulate a DEC VT220, VT100, or VT52 terminal directly connected 
to a remote host. This section explains how to use the 
TNVT220 utility.
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Starting TNVT220

To start TNVT220, follow these steps:

1. If not already loaded, load TelAPI by entering the 
following command at the DOS prompt:

C> TELAPI

A message similar to this is displayed:

TELAPI - Copyright © 1990 Novell, Inc. LAN Workplace for DOS

Number of Sessions: 2
Number of Stacks: 1

Refer to the LAN Workplace for DOS Administrator's Guide for 
information on the TelAPI options.

If you requested the installation program to modify your 
AUTOEXEC.BAT file, TelAPI is automatically loaded 
when you start your workstation.

2. Start TNVT220 by entering a command in the following 
format at the DOS prompt:

C> TNVT220 [ remotejiost]

If you omit remotejiost, you enter command mode. The 
system displays the TNVT220> prompt and you can perform 
any TNVT220 commands.

If you specify remotejiost, you enter terminal mode. 
TNVT220 prompts you to log in then establishes a session to 
that host. The remote host's system prompt is displayed. You 
can now execute any command that the remote 
host understands.

6-2 Using the TNVT220 Terminal Emulator



Using Your Workstation as a Terminal

Status Line

When you establish a TNVT220 session with a remote host, 
TNVT220 displays a status line at the bottom of your screen, if 
the following are true:

• You are emulating a VT52, VT100, or VT220 terminal.

• You did not turn the status line off the last time you were 
in TNVT220 setup mode.

• You did not open TNVT220 with the -X option.

Figure 6-1 shows how TNVT220 displays information on the 
status line. Each part is explained below:

• TNVT220 - Novell, Inc. - TNVT220 product identification.

• remotejwst - First 19 characters of the remote host's name 
or IP address.

• # - Current session ID.

• mode - Indicate whether the terminal emulator is in 
replace (Rep) or insert (Ins) mode.

• time - Current time on your workstation.

• A (caret) - Displayed when you press the Ctrl key.

• ? (up-arrow) - Displayed when you press the Shift key.

• A - Displayed when you press the Alt key.

• N - Displayed when Num Lock is on.

• C - Displayed when Caps Lock or Shift Lock is on.

• H - Displayed when Scroll Lock is on. (This is equivalent 
to Hold Screen.)

TNVT220 - Novell, Inc. remote_host (#) mode time * T ANCH

Figure 6-1
TNVT220 Status Line
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Establishing Multiple Sessions

TNVT220 lets you establish up to 10 sessions with the same host or 
with different hosts. To establish multiple sessions, start TNVT220 
(as described in the section Starting TNVT220) and establish a 
session with a remote host

Before you can establish another session with a remote host, you 
must suspend the current session and return to TNVT220 
command mode. To do this, press Alt-T. When the TNVT220 
prompt is redisplayed, enter a command in the following format:

TNVT220> OPEN remote_host

TNVT220 prompts you to log in and then establishes a session to 
remote_host.

For each additional session you want to establish, you must first 
return to command mode and then execute the OPEN command.

Although only one session can be active (current) at a time, you 
can switch between sessions.

When you are in terminal mode for a particular session, you can 
switch from one session to another, by pressing Alt-N 
(NextScreen).

When you are in command mode, you can switch the current 
session and either resume an established session or remain in 
command mode. You can also display information about all 
established sessions.

To switch sessions and resume an established session, enter a 
command in the following format:

TNVT220> RESUME [ session_number | remote_host]

If you specify session_number or remote_host, the session associated 
with the specified number or name becomes the current session and 
you resume that session. If you omit the options, this command 
resumes the previous current session.
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To switch the current session but remain in command mode, 
enter a command in the following format:

TNVT220> SELECT { session_number | remote_host}

To display information about all established sessions, enter the 
following command:

TNVT220> SESSIONS

The system responds with a display similar to the following:

Available session(s):
Session Id Destination

Internet Address 

1
2

80.24.1.132
80.14.1.13

Host Name

Chicago 
atlanta

The asterisk (*) indicates the current session.

Printing a Copy of the Terminal Screen

If a printer is connected to your workstation while you are using 
TNVT220, you can print what an application (running on a remote 
host) displays on your screen.

To print, follow these steps:

1. Make sure the printer is set up properly and attached to 
your workstation.

2. Establish a TNVT220 session to a remote host.

3. Press Alt-S to enter TNVT220 setup mode.

TNVT220 displays the Setup Directory screen.

4. Select the printer option by highlighting it using the arrow 
keys.

5. Press either the grey + or the Enter key from the numeric 
keypad to display the Printer Setup screen.
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6. Define the following printer characteristics by highlighting 
each field using the arrow keys. Then press either the 
grey + or the Enter key from the numeric keypad, until the 
desired characteristic is displayed:

a. Specify the port (either parallel or serial) to which the 
printer is attached. The default printer port is PRN:.

b. Set the number of characters the printer can print on 
one line. You can set this for parallel ports only. The 
default value is 80 characters per line.

c. Set the printer operating mode to normal, auto, or 
controller. The default mode is normal.

d. Set the number of lines printed per inch. You can set 
this for parallel ports only.

For information about printer characteristics, refer to the 
section Printer Setup Screen in the LAN Workplace for DOS 
Administrator's Guide.

7. Press Alt-P to print a screen.

1111^ When your workstation is not emulating a terminal, 
normally you press Shift-PrtSc to print a screen. 
However, when your workstation is emulating a 
terminal, you must use Alt-P because the 
computer's ROM BIOS (which handles the printing) 
is not synchronized with the TNVT220 software.
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Running a DOS Program While In TNVT220

You can suspend a TNVT220 session, return to the DOS prompt, 
and run a DOS program using one of the following methods:

• When you are in TNVT220 command mode, enter the ! 
(exclamation point) command and press the Enter key:

TNVT220> !

• When you are in any other mode (except setup mode), 
press Alt-D.

1111^ You cannot suspend a TNVT220 session and return 
to the DOS prompt when TNVT220 is in setup 
mode.

When you suspend a TNVT220 session, TNVT220 returns you to 
the DOS prompt. You are on the drive and in the directory you 
were in before you started or last suspended TNVT220.

To return to the TNVT220 session that you suspended, enter the 
following command and press the Enter key:

C> EXIT

llll^ If you execute the DOS SET command while a TNVT220 
session is suspended, any characteristics you set affect only 
that DOS session. When you quit TNVT220 and return to the 
DOS prompt, all SET characteristics are restored to the values 
they had before you started TNVT220.
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Unloading TELAPI

Closing or Quitting a TNVT220 Session

When you finish a TNVT220 session with a remote host, you can 
close the session with the remote host and either remain in 
TNVT220, or quit TNVT220 and return to the DOS prompt.

One way you can close a session is to log out from the remote 
host. If you have only one session open when you log out, 
TNVT220 quits and returns you to the DOS prompt. If you have 
more than one session open when you log out, TNVT220 returns 
you to the TNVT220 prompt.

You can also close a specific session and remain in TNVT220 by 
entering a command in the following format:

TNVT220> CLOSE [ session_number | session_host]

If you specify the session ID, session_number, or the name of the 
remote host, session_host, TNVT220 closes the specified session. If 
you omit the options, TNVT220 closes the current session.

To close all sessions, exit from TNVT220, and return to the DOS 
prompt, enter the following command:

TNVT220> QUIT

TNVT220 displays the following prompt:

One or more sessions currently exist. Do you want to exit ( Y | N ): Y

If you enter Y, TNVT220 quits and returns you to the DOS 
prompt. You are on the drive and in the directory you were in 
prior to starting TNVT220. Any characteristics that you redefined 
with the DOS SET command are restored to the values they had 
prior to starting TNVT220.

After you exit from TNVT220, you can unload TelAPI to free the 
allocated data space. To do so, enter the following command at 
the DOS prompt:

C> TELAPI -u
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Connecting to a Different National Language Host

TNVT220 lets you connect your workstation to the following 
national language hosts:

• British

• Danish

• Dutch

• Finnish

• Belgian

• French

• French Canadian

• German

• Italian

• North American

• Norwegian

• Spanish

• Swedish

• Swiss (French)

• Swiss (German)

• Multinational

To emulate any of the above terminals, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.
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3. Select the terminal type field using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad, until the desired terminal type is 
displayed.

If you want TNVT220 to open sessions automatically with 
this terminal type, continue with Step 4. Otherwise, skip to 
Step 5.

4. Select the Save option using the keyboard's arrow keys. 
Then press the grey + or the Enter key on the numeric 
keypad to save the setting.

5. Press Alt-S to exit from the Setup Directory screen and 
return to the TNVT220 session.

When you select a particular terminal type, such as German, you 
can send and receive German symbols and characters from the 
host. If you press a key that is not available in the German 
character set, the keyboard beeps.

For information about national language hosts, refer to the LAN 
Workplace for DOS Administrator's Guide.

Redefining the Back Arrow Key

When you press the Backspace key (the <- Backspace key) on the 
main keyboard, it deletes the character immediately proceeding 
the cursor. Depending on the system, pressing the Backspace key 
generates either a backspace character or a delete character. Some 
hosts expect the Backspace key to generate a backspace character. 
Other hosts expect the Backspace key to generate a delete 
character. The character to the left of the cursor is deleted only if 
the host receives the character it expects.

By default, TNVT220 generates a backspace character when you 
press the Backspace key. However, when you open a session with 
a host that expects a delete character (such as a host running the 
VMS operating system), you must change the default setting of 
the Backspace key and set it to Delete.
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To change the default setting of the Backspace key, follow these 
steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Keyboard field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the Keyboard Setup screen.

5. Select the field Backspace=BS, using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad, to toggle the field to Backspace=Del.

If you want TNVT220 to open sessions automatically with 
the selected back arrow setting, continue with Step 6. 
Otherwise, skip to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit from the Setup Directory screen and 
return to the TNVT220 session.

Other TNVT220 Features

Once you establish a TNVT220 session, TNVT220 lets you set the 
following features:

• Screen color

• Hardware versus ROM-BIOS screen access

• VT200 mode versus VT100 mode

This section describes how to set these features.
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Screen Color
If you have a color monitor, once you have established a TNVT220 
session you can define the foreground and background color of 
your screen. You can also define the color of the bold and 
underlined characters on the screen. If you established multiple 
TNVT220 sessions, you can specify a different set of colors for each 
session; however, you can save only one set as the default colors. 
The following colors are supported for color monitors: green, white, 
black, blue, cyan, red, magenta, and brown.

To change the colors of your screen display, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Display field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the Display Setup screen.

5. Select the color field you want to change, using the 
keyboard's arrow keys. Then press the grey + or the Enter 
key on the numeric keypad, until the desired color is 
displayed.

If you want TNVT220 to open a session automatically with 
the selected colors, continue with Step 6. Otherwise, skip 
to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit the Setup Directory screen and return to 
the TNVT220 session.

For further information about screen colors, refer to the 
description of the Display Setup screen in the LAN Workplace for 
DOS Administrator's Guide.
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Direct Hardware Versus ROM-BIOS Screen Access
TNVT220 lets you determine the screen-access mode when 
emulating a VT52, VT100, or VT220 terminal. The TNVT220 
software can access the screen in either of the following modes:

• Direct hardware - In direct-hardware mode, you access 
the screen via the workstation's video adapter board. 
Because of this, your video adapter board must be 100% 
compatible with a standard display adapter (such as an 
MDA, a CGA, a Hercules-compatible adapter, an EGA, or 
a VGA board). Use this method when running TNVT220 
under Windows 3.0 Enhanced mode or under DESQView.

• ROM-BIOS - In ROM-BIOS mode, you access the screen 
via the workstation's ROM BIOS. ROM-BIOS mode works 
with all PC compatibles, even if they have incompatible 
display adapters. You must use this method when running 
TNVT220 under Windows 3.0 Standard or Real mode.

1111^ Running TNVT220 in direct-hardware mode gives 
the best performance. Use ROM-BIOS access mode 
only if you have compatibility problems or 
environmental restraints.

The default screen-access mode is the direct-hardware mode. To 
change to ROM-BIOS mode, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the Display field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad 
to display the Display Setup screen.

5. Select the HardwareAccess field, using the keyboard's 
arrow keys. Then press the grey + or the Enter key on the 
numeric keypad to toggle the field to ROM-BIOS Access.

If you want TNVT220 to open a session automatically with 
the selected mode, continue with Step 6. Otherwise, skip 
to Step 7.
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6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit the Setup Directory screen and return to 
the TNVT220 session.

VT200 Mode Versus VT1D0 Mode
The VT200 mode executes standard ANSI functions and lets you 
use the full range of VT220 capabilities. For application programs 
that expect 7-bit control characters, and either ASCII characters 
or national replacement characters, you must use the VT200 
mode, 7-bit setting. Most VT100 application programs will run in 
this setting. For application programs that send and receive 8-bit 
control characters and DEC multinational characters, you must 
use the VT200 mode, 8-bit setting.

The VT100 mode executes standard ANSI functions. You must 
use this mode with application programs that require strict 
compatibility with Digital's VT100 terminal.

To change the mode, follow these steps:

1. Establish a TNVT220 session with the desired host.

2. Press Alt-S to display the Setup Directory screen.

3. Select the General field using the keyboard's arrow keys.

4. Press the grey + or the Enter key on the numeric keypad to 
display the General Setup screen.

5. Select the VT200 mode, 7-bit field, using the keyboard's 
arrow keys. Then press the grey + or the Enter key on the 
numeric keypad, until the desired mode is displayed.

If you want TNVT220 to open a session automatically with 
the selected mode, continue with Step 6. Otherwise, skip 
to Step 7.

6. Press the Esc key to return to the Setup Directory screen, 
and select the Save option using the keyboard's arrow 
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keys. Then press the grey + or the Enter key on the 
numeric keypad to save the setting.

7. Press Alt-S to exit and return to the TNVT220 session.

Using Third-Party Terminal Emulators

The Telnet Session Utility (TSU) lets third-party, LAN-compatible 
data communication applications use TelAPI. When using 
TelAPI, the third-party application can communicate with remote 
hosts that are running the Telnet client program.

TSU uses TelAPI to open and close Telnet sessions with remote 
hosts. TSU also lets you configure the Telnet session used by the 
application. You.can configure the Telnet session by specifying 
command-line options when you start TSU. After you have 
started TSU, you can configure the Telnet session by selecting 
options from the TSU menus.

Using TSU, you associate a EOS serial port with a Telnet session 
to a remote host. The DOS serial port used is the one to which the 
third-party application would normally direct its data. TSU 
redirects the data from third-party application to the remote host 
via the associated DOS serial port.

You can call TSU from a batch file. Figure 6-2 shows a sample 
batch file that opens one Telnet session and then starts a 
third-party terminal emulator.

Starting TSU

To start a session with a remote host and then run a third-party 
terminal emulator, follow these steps:

1. Load TelAPI:

C> TELAPI -SN sessions

sessions can be a value from 0 to 10. The default value is 2.
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Figur« 6-2
TSU Batch File echo off

rem Open a session to the host kansas with hostid k1 
tsu -o kansas k1
if errorlevel 1 goto open_error
rem Attach hostid kl to COM3
tsu -a k1 COM3
if errorlevel 1 goto attach_error
rem Start third-party terminal emulator 
program_name
rem Close the session
tsu —c k1
if errorlevel 1 goto close_error 
goto exit
rem
:open_error
echo Open session failed
goto exit
:attach_error
echo Attach session failed
goto exit
:close_error
echo Close session failed
:exit
tsu —c k1

llll^ Each session requires about 1700 bytes. When using 
TelAPI with third-party terminal emulators, you 
must allocate space for at least one session.

2. Start TSU:

C> TSU

TSU displays the main menu (see Figure 6-3). This menu is 
divided into two areas, the Sessions List and the Session 
Utility Commands. The Sessions List displays all the 
currently open sessions. The Session Utility Commands 
displays the function keys you use to open, close, and 
configure sessions. When a function key is highlighted, a 
short description of it is displayed at the bottom of the 
Session Utility Commands.
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Figure 6-3
TSU Main Menu

  Sessions List 
No. Host Name Id------------------- Port

1 sales 89.32.8.83 COM1

Connection established successfully

1 Help 31Open
I------------------- Session Utility Commands

4 Close 5 Config 6 Attach 7 Reset 8 Unload 9 Update 10 Exit

Open a Telnet session

3. Press function key F3 (Open) to open a session with a 
remote host.

The system prompts you for the name of the remote host.

4. Enter the name of the remote host and press the Enter key.

The system prompts you for a session ID.

5. Press the Enter key to accept the default value, or enter a 
session ID and press the Enter key.

The system prompts you for the port number.

6. Press the Enter key to accept the default port number, or 
enter a port number and press the Enter key.
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llll^ Specify a remote port number only if you know that 
the Telnet server on the remote host is not using the 
default Telnet TCP port.

1111^ The third-party emulator must be configured to 
access the port associated with the TSU session.

TSU opens the session with the remote host and attaches the 
session to a port. (TSU automatically attaches the first session 
to port COM1, the second to COM2, and so on.)

7. Press function key F10 (Exit) to exit from TSU.

8. Enter the name of the emulator program at the DOS 
prompt, to run your third-party terminal emulator.

Following Step 8, you have started a Telnet session with a 
third-party terminal emulator.

Ending a Session with a Third-Party Terminal Emulator

To end a session with a third-party terminal emulator, log out 
from the remote host at the terminal emulator prompt. When you 
do this, TelAPI automatically closes the TSU session. However, if 
the session does not close, you must start TSU by entering the 
following command at the DOS prompt:

C> TSU

When TSU displays the main menu, press F4 (Close) to close the 
session. The system prompts you for confirmation. Enter Y to 
close the session. After you close the session, you can use TSU to 
unload TelAPI by pressing F8.

1111^ If you unload TelAPI, you must exit TSU before you can 
reload TelAPI.
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TRANSFERRING FILES

The LAN Workplace software provides three command-line 
utilities that let you transfer files between your workstation and a 
remote host.

• File Transfer Program (FTP) - Lets you access files and 
directories on the local or remote host, transfer single or 
multiple files, and perform common directory and file 
operations. FTP performs user authentication on the 
remote host based on passwords.

• THvial File Transfer Program (TFTP) - Lets you transfer 
single files. TFTP performs no user authentication.

• Remote Copy Program (RCP) - Lets you transfer single or 
multiple files. RCP performs user authentication based on 
entries in the HOSTS.EQUIV and .RHOSTS files. Refer to 
the LAN Workplace for DOS Administrator's Guide for a 
discussion of these files.

Using the File Transfer Program (FTP)

The TIP utility lets you transfer files between your workstation 
and a remote host on the local or remote network. FTP also lets 
you access local and remote directories and files and perform 
common directory and file operations. These operations include 
listing and changing working directories, listing directory 
contents, and renaming directories and files.

1111^ Before you can use FTP, the remote host must be running 
an FTP server program.
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Starting FTP

You can start FTP and log in to a remote host, if the following 
conditions are true:

• The remote host recognizes you as a valid user.

• You can provide a password, if one is required by the 
remote host.

• An entry for the remote host is present in the host name 
database. The database is either a Domain Name System 
(DNS) name server (if one exists on your network) or the 
file \XLN\TCP\HOSTS on your workstation.

To start FTP and log in to a remote host, enter a command in the 
following format at the DOS prompt:

C> FTP [ remotejiost ]

If you specify remotejiost, FTP prompts you to log in and then 
connects you to that host. If you omit remotejiost, Fir prompts 
you for the name of the remote host.

Assume that the user Evelyn wants to log in to the remote host 
sales. To do this, she can start FTP and log in to sales using either 
of the following methods.

Method 1:

C> FTP
ftp> OPEN sales
Connected to sales
220 sales FTP Server (<version> <date>) ready.
Remote user name: evelyn
Password: password
ftp>

Method 2:

C> FTP sales
Connected to sales.
220 sales FTP Server (<version> <date>) ready.
Remote user name: evelyn
Password: password
ftp>
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Getting File and Directory Information

After you start Fi l-’, you can use FTP commands for operations 
such as getting file and directory information, listing directory 
contents, and changing working directories.

The FTP HELP command lists all available FTP commands:

ftp> HELP

llll^ There are more FTP commands available when a session is 
open (active) than when no sessions are open.

When you first open a connection to a remote host, you are in 
your home directory on that host. You can find the full pathname 
of this directory with the following command:

ftp> PWD

Information similar to the following is displayed.

7x/sales/evelyn" is current directory.

You can list the contents of the current working directory on the 
remote host with either of the following commands:

ftp> DIR
ftp> LS

If the remote host is a UNIX system, the DIR command gives a 
detailed list of the directory's contents similar to the following:

-rw-r-r- 1 evelyn 425 Oct 22 16:56 calendar
drwxr-xr-- 2 evelyn 512 Sep 15 16:36 general
drwxr-xr- 2 evelyn 1536 Oct 26 12:44 status
drwxr-xr- 2 evelyn 512 Jul 2 10:19 updates

The LS listing for the same directory would look like this:

calendar
general 
status 
updates
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You can change the working directory on the remote host by 
entering a command in the following format:

ftp> CD remote_directory

IIIM^ You must specify the name of the remote directory in a 
form that the remote host understands. For example, if the 
remote host is a UNIX system, separate directory names 
with slashes (/); if the remote host is a VMS system, 
separate the directory names with periods (.) and enclose 
them in square brackets ([ ]).

You can perform the same operations for files and directories on 
your workstation using the LPWD, LDIR, LLS, and LCD 
commands. The letter "L" preceding the command name 
indicates that the command is performed locally. To execute these 
commands you do not need to be connected to a remote host. 
The following sequence of commands illustrates the responses to 
these Fir commands:

C> FTP
ftp> LPWD

"c:\" is current directory.
ftp> LCD MKTG
ftp> LLS
memos
bulletin.txt
reportl .doc
report2.doc
mktg.gem

ftp> LDIR
memos <DIR> 4-23-87 12:01
bulletin.txt 6978 10-06-87 12:30 RA
reportl .doc 15927 10-29-87 12:45 A
report2.doc 21734 10-30-87 1:03
mktg.gem 8133 10-29-87 1:25 A
5 File(s)
ftp>

The LDIR command lists the file or directory name, the length of 
the file (or <DIR> to indicate a directory), the date and time the 
file or directory was last modified. It may list whether the file has 
been modified since the last backup archive (A) and whether the 
file is read-only (R). These are DOS file attributes.
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Copying Files

The HP commands lets you copy files between your workstation 
and the remote host, or between two remote hosts.

1111^- If the remote host has a case-sensitive file system, such as 
UNIX, all remote file names must be entered in the proper 
case. This is necessary for all FTP commands.

Copying Files to a Remote Host
You can use the following HP commands to copy one or more 
files from your workstation to a remote host:

• PUT - Copy one file to a remote host

• MPUT - Copy one or more files to a remote host

• COPY - Copy one or more files or directories, or a 
directory tree to a remote host

The following examples show you how to use the commands 
PUT and MPUT. The COPY command is discussed in the section, 
Copying Files Between Remote Hosts.

To copy the file REPORT1.DOC from your workstation to the 
current directory on the remote host and retain the name 
REPORT!.EXDC:

ftp> PUT REPORT1.DOC

To copy the file REPORT! .EXDC from your workstation to the 
directory reports on the remote UNIX system and rename the file 
reportl.txt:

ftp> PUT REPORT1.DOC report sZreport1.txt

To copy all files with the extension .EXDC from your workstation 
to the current directory on the remote host:

ftp> MPUT *.DOC

Using the File Transfer Program (FTP) 7-5



LAN Workplace for DOS User's Guide

Copying Files to Your Workstation
You can use the following HP commands to copy one or more 
files from a remote host to your workstation:

• GET - Copy one file to your workstation

• MGET - Copy one or more files to your workstation

• COPY - Copy one or more files or directories, or a 
directory tree from a remote host

The following examples show you how to use the GET and 
MGET commands. The COPY command is discussed in the 
following section, Copying Files Between Remote Hosts.

To copy the file report1.txt from the current directory on the 
remote UNIX system and retain the name reportl.txt:

ftp> GET report1.txt

To copy the file reportl.txt from the current directory on the 
remote UNIX system to the directory REPORTS on your 
workstation and rename it REPORTLDOC:

ftp> GET reportl.txt REPORTS\REPORT1.DOC

To copy all files that start with the name report (and that conform 
to the local naming conventions) from the current directory on 
the remote UNIX system to the current directory on your 
workstation:

ftp> MGET report*

Copying Files Between Remote Hosts

The FTP COPY command lets you copy files between two remote 
hosts as well as between your workstation and a remote host. It 
also lets you copy an entire directory and all its subtrees.

Illl^ When you use the COPY command, FTP automatically 
opens connections to the remote hosts (if they are not yet 
open), copies the specified files, and then closes the 
connections when it is finished copying the files.
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Table C-4
RPR, RPS, and RPD Error Messages (Continued)

Error Message Explanation

Not processing file 
<file name>. 
Cannot determine file 
type: <LAN Workplace 
system message>

RPR cannot determine if the file is a text file or a binary file, and it will 
not print the file. RPR continues with the next file in the command line.

Not processing file 
<filename>. Failed to 
open file:<LAN 
Workplace system 
message>

One of the files you specified on the RPR command line does not exist. 
RPR skips this file and continues with the next file on the command line.

Permission denied The .RHOSTS file does not contain an entry for the name of the user or 
workstation you specified.

Try to connect to remote 
host: <LAN Workplace 
system message»

The attempt to connect to the remote host or to the RSH server on the 
remote host failed. Check the status of the remote host and its RSH 
server.

unknown host The remote host you specified is not in your workstations's host file.

usage:... You specified options incorrectly on the command line. This error 
messages shows the correct command-line format.

User abort of program. You aborted the RPR command by pressing Ctrl-C or Ctrl-Break. The 
RPR command may not have concluded.

Your username must be 
in the environment table. 
...SET NAME - 
<user_name>

Execute the DOS SET NAME command and set your DOS username to 
be the same as your login name on the remote host. The LAN 
Workplace for DOS software appends the SET NAME command to your 
AUTOEXEC.BAT file during installation.

□
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TNVT220 Error Messages

All error messages that occur when you are using the TNVT220 
utility originate from the local host The common error messages are 
listed in alphabetical order and explained in Table C-5. If TNVT220 
displays any messages that are not self-explanatory and that 
interrupt your work, contact your network administrator or refer to 
the LAN Workplace for DOS Administrator's Guide.

Table C-5
TNVT220 Error Messages

Message Explanation

Ambiguous command 
name specified with the 
? or HELP command

You specified an ambiguous abbreviation of a command name with the 
? or HELP command. Command name should be more specific.

Ambiguous command, 
please be more specific

You entered a TNVT220 command abbreviation that matches another 
TNVT220 command (for example, SE could be SELECT or SESSIONS). 
Be more specific.

Connection refused (1) The remote server is busy. Try again later. (2) The remote server does 
not have the proper server software. Contact your network 
administrator or the administrator of the remote host. (3) The remote 
server is not running. Try again later.

Connection reset by 
peer

The remote host may have detected an error at the remote end of the 
connection. Contact your network administrator or the administrator of 
the remote host.

Connection timed out The attempt to communicate with the remote host failed. The remote 
host may not be functioning or the path to it has been severed. Try again 
later or contact your network administrator.

Host is down The remote host is not functioning. Contact your network administrator 
or the administrator of the remote host.
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Table C-5
TNVT220 Error Messages (Continued)

Message Explanation

Hostname missing, 
entering command 
processor

You did not specify a hostname when you entered the TNVT220 
command; therefore, TNVT220 is in command mode. To open a session 
with the desired host, execute the OPEN command.

Host name missing, 
please reenter the 
command with a 
host name

You must specify a hostname with the OPEN command.

Invalid or insufficient 
arguments, please 
check format

You specified invalid or insufficient arguments with the TNVT220 
command. Enter 'HELP command-name? for the correct format.

Invalid command The command you entered at the TNVT220 prompt is invalid. Use the 
HELP command for a list of valid commands.

Invalid command 
name specified with 
the ? or HELP command

You specified an invalid or unsupported command name with the ? or 
HELP command. Check for spelling errors.

Invalid option(s) 
specified with 
the command

You specified one or more invalid options with the TNVT220 command.
For the correct format, enter TNVT220 -H at the DOS prompt.

Invalid or insufficient 
arguments, please 
check format

You specified invalid or insufficient arguments with the TNVT220 
command. Enter 'HELP commandjiam^ for the correct format.

Invalid VT220 function 
keys map file 
<filename>

Contents of the file name specified with the -F option are invalid and 
cannot be used by TNVT220. The specified file may not be a valid 
keyboard map file.

Keyboard selection 
failed, file 
PCTOHOST.MAP 
not found

TNVT220 is unable to find file PCTOHOST.MAP in LAN Workplace for 
DOS directory. TNVT220 cannot proceed without this file.
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Table C-5
TNVT220 Error Messages (Continued)

Message Explanation

Map filename too long The name of the map file you specified with the TNVT220 -F option 
exceeds 50 characters.

Maximum sessions 
limit exceeded

You tried to open more than the 10-session maximum.

Network dropped 
connection on reset

Connection to the remote host was interrupted and lost, and the state of 
the operation in progress (if any) cannot be determined. Try again.

Network is down Your workstation cannot communicate with the network. Try again later.

Network is 
unreachable

There is no known route to the remote host, the remote network, or 
both. Contact customer support.

No other sessions 
are currently 
established

Your attempt to switch to another session failed because currently you 
have only one TNVT220 session.

No route to host No route exists to the remote host. Contact your network administrator 
or the administrator of the remote host.

No sessions are 
currently established

Currently, there are no existing TNVT220 sessions.

Not enough memory Insufficient DOS memory to perform the specified operation.

Not sufficient privilege 
for operation

You do not have the proper permission(s) for the operation you 
attempted.

Permission denied You do not have the proper permission(s) for the operation you 
attempted.

Software caused 
connection abort

The local system detected an error at the remote end of the connection. 
Contact your network administrator.
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Table 05
TNVT220 Error Messages (Continued)

Message Explanation

The name is not 
unique, please use 
session id

Either you specified an ambiguous hostname with the command or you 
have more than one session to the same host. Use the session id to 
identify the target host.

The specified session 
does not exist

You specified a nonexistent session id with a TNVT220 command.

There is no session 
to the specified host

You specified a nonexistent hostname with a TNVT220 command.

Too many arguments 
specified with the 
command

The number of arguments specified with the command exceeds the 
maximum number allowed.

Unable to find VT220 
function keys map file 
<filename>

TNVT220 was unable to find file 'filename' specified with the -F option. 
Check for pathname or filename errors.

Unable to open a 
new session

An error occurred while trying to open a new session. TNVT220 could 
not establish the requested session.

Unable to restore The session screen of the resumed session can not be restored either 
because you or another program erased the session screen file, or 
TNVT220 was activated with -X option.

Unable to resume 
the specified session

The system failed and TNVT220 cannot resume the specified session.

Unknown host The host you specified is not in the DNS name server's host table (if you 
have a name server on the local network) or in your workstation's host 
name database.

TNVT220 Error Messages C-15



LAN Workplace for DOS User's Guide

LAN Workplace System Error Messages

Some of the error messages returned by the HostAccess utilities 
refer to LAN Workplace system error messages. Table C-6 lists 
the most common of these messages in alphabetical order and 
explains them.

If the explanations given in this appendix and throughout this 
manual do not solve or isolate a persistent problem, refer to the 
LAN Workplace for DOS Administrator's Guide or contact Novell at 
the following address and telephone number:

Customer Support Response Center 
Novell, Inc.
2180 Fortune Drive
San Jose, CA 95131
(408) 473-8700

Table 06
LAN Workplace System Error Messages

Error Message Explanation

Address already in use. Multiple servers of the same type (such as FTPD) are running 
concurrently on the same network port.

Bad file number. You tried to write to a read-only drive, or made a close request for a 
nonexistent socket.

Connection refused. The remote host did not accept the connect request. The remote host 
may not be running the server required by the application.

Connection timed out. The remote system is not responding. Either the remote system is not 
running, or there is an addressing problem.

File exists. (1) A file with the same name already exists. (2) A bad request code was 
passed to the routing code (on the EXOS board). (3) An attempt was 
made to delete the entry for the default gateway.
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Table C-6
LAN Workplace System Error Messages (Continued)

Error Message Explanation

File name expansion The file name you specified with wildcard characters expanded into
yielded wrong number more than one file name.
of arguments.

File name too long. You specified an invalid DOS file name.

Host is down. The remote host is inaccessible. It is either turned off, or TCP/IP
protocol software is not running or allowing you to connect to the host.

Interrupted system call. You pressed Ctrl-C or Ctrl-Break and stopped a network operation.

Invalid file name format. The file name specified either was a reserved name for a DOS device or
contained invalid characters.

Is a directory. (1) The program required a file for the operation, but the name specified
was not a file. (2) In FTP and RCP, you omitted the -R option to indicate
a recursive operation.

Mismatch between file In FTP, you tried to force a transfer of a file using incompatible
type and transfer parameters. The file was not transferred.
parameters.

No space left on device. The disk is full.

No such file or directory. The file or directory specified does not exist.

Not a directory. The program required a directory for the operation, but the name
specified was not a directory.

Not enough core. Not enough memory is available to allocate data space or to run
COMMAND.COM.

Read-only file system. The program tried to write to a read-only file or device.

Unknown host name. The host name is not found in host name database.

□
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